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Revision History

Changes to the original guide are listed below:

Change Date Description

-01 Rev A 01/2016 Initial release.

-02 Rev A 12/2016 Add: WifiReconnectService; Kiosk application; Mounts Guides under Related 
Documents; Properties under TekWedge. 

-03 Rev A 05/2017 Add VC80 Windows 10 configuration and software chapter.
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ABOUT THIS GUIDE
Introduction

This guide provides instructions for setting up, operating, configuring, and maintaining the VC80 vehicle-mount 
computer.

NOTE     Screens and windows pictured in this guide are samples and can differ from actual screens.

WARNING! Before transporting, assembling, and starting the computer, please read this manual 
carefully and follow all the safety guidelines and requirements.
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Configurations

VC80 Windows 7 Configurations

The VC80 offers different configurations to suit various work requirements. Some of the configuration options 
include:

• Intel E3825 Dual Core, 1.33 GHz, 1 MB Cache, 2 GB RAM

• Intel E3845 Quad Core, 1.91 GHz, 2 MB Cache, 4 GB RAM

• SSD (32 GB or 64 GB)

• Sunlight Readable Display

• Internal Antenna

• External Antenna

• Freezer Condensing

• Windows Embedded Standard 7

• Windows 7 Professional for Embedded Systems

• Basic I/O

• CanBus

• Ethernet

Configurations for VC80 Windows 10

The VC80 offers different configurations to suit various work requirements. Some of the configuration options 
include:

• Intel E3845 Quad Core, 1.91 GHz, 2 MB Cache, 4 GB RAM

• SSD (64 GB)

• Sunlight Readable Display

• Internal Antenna

• External Antenna

• Freezer Condensing

• Windows Embedded Standard 7

• Windows 10 IoT Enterprise 2016 LTSB Entry

• Basic I/O

• CanBus

• Ethernet

NOTE For detailed configuration and part number information, contact your Zebra representative.
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Chapter Descriptions

Topics covered in this guide are as follows:

• Chapter 1, Getting Started, provides information on safety guidelines and initial VC80 setup.

• Chapter 2, Installation, provides instructions on installing the VC80.

• Chapter 3, Software Windows 7, explains how to configure the VC80 with Windows 7.

• Chapter 4, Software Windows 10, explains how to configure the VC80 with Windows 10.

• Chapter 5, Maintenance and Troubleshooting, includes instructions on cleaning the VC80 and provides 
troubleshooting solutions for potential problems during device operations.

• Chapter 6, Accessories and Mounting, describes the accessories and mounting options available for the 
VC80.

• Chapter 7, Scancode Map, provides information on the integrated scancode maps for the VC80.

• Appendix A, Specifications, summarizes the device’s intended operating environment and technical 
specifications.

Notational Conventions

The following conventions are used in this document:

• Italics are used to highlight the following:

• Chapters and sections in this guide

• Related documents.

• Bold text is used to highlight the following:

• Dialog box, window and screen names

• Drop-down list and list box names

• Check box and radio button names

• Icons on a screen

• Key names on a keypad

• Button names on a screen.

• Bullets (•) indicate:

• Action items

• Lists of alternatives

• Lists of required steps that are not necessarily sequential.

• Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.
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Related Documents and Software

The following document provides more information about the VC80 vehicle-mount computer.

• VC80 Quick Reference Guide, p/n MN002383Axx - includes VC80 setup information and regulatory 
information.

• U-Mount Bracket Installation Guide, p/n MN-002931-xx - includes the instructions to install the U-Mount 
Bracket Kit (KT-U-MOUNT-VC80-R) and dimensions. 

• Adapter Bracket Kit for VC50 U-Mount Installation Guide, p/n MN-002932-xx - provides instruction on 
installing the Adapter Bracket Kit (MNT-VC80-ADPA1-1) to attach the VC80 to the VC5090 U-Mount. 

• Adapter Bracket Kit for Honeywell U-Mount Installation Guide, p/n MN-002934-xx - provides instruction on 
installing the Adapter Bracket Kit (MNT-VC80-ADPB1-1) to attach the VC80 to the Honeywell U-Mount 
Bracket. 

For the latest version of this guide and all guides, go to: http://www.zebra.com/support.

Service Information

If you have a problem with your equipment, contact Zebra Customer Support for your region. Contact information is 
available at: http://www.zebra.com/support.

When contacting support, please have the following information available:

• Serial number of the unit

• Model number or product name

• Software type and version number.

Zebra responds to calls by email, telephone or fax within the time limits set forth in support agreements.

If your problem cannot be solved by Zebra Customer Support, you may need to return your equipment for servicing 
and will be given specific directions. Zebra is not responsible for any damages incurred during shipment if the 
approved shipping container is not used. Shipping the units improperly can possibly void the warranty.

If you purchased your Zebra business product from a Zebra business partner, contact that business partner for 
support.

http://www.zebra.com/support
http://www.zebra.com/support


CHAPTER 1 GETTING STARTED
Introduction

The VC80 is a rugged, vehicle mounted computer running Microsoft Windows Embedded Standard 7 and Windows 
Professional for Embedded Systems operating systems. Wireless communications are supported over a 802.11 
WLAN network. The Bluetooth module supports Bluetooth printers and scanners. The VC80 can be used with or 
without an external keyboard. There are six programmable macro keys on the front bezel and when used with the 
Blue modifier key, provides six additional programmable keys. 

The VC80 is intended for use in commercial and industrial applications with a focus on real time wireless data 
transactions with options suiting materials handling applications in warehouses, manufacturing facilities, ports, 
yards, and freezers. 

Unpacking

Carefully remove all protective material from the device and save the shipping container for later storage and 
shipping.

Inspect the equipment for damage. If any equipment is missing or damaged, contact the Zebra Support Center 
immediately. See Service Information on page xii for contact information.

Removing the Protective Film from the Display

The front display of the VC80 is protected during transport by a transparent film. This film should remain on the 
front display during assembly to avoid damage to the front display surface. Only remove the film once all of the 
assembly work has been completed.

WARNING! Before operating the unit for the first time, carefully read Safety on page 1-2.

NOTE     Configure the computer before fastening it to machines or vehicles. 
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Safety

In order to prevent injury and damage, observe the following safety guidelines prior to assembly and 
commissioning. The VC80 is a multifunction terminal for stationary and mobile use in commercial environments 
such as, warehouses, manufacturing, yard/ports, and freezers. Different or extraordinary usage is not permitted. 
For resulting damage, the user/operator of the VC80 is solely responsible. This also applies to any changes that 
you make to the device. Compliance with the safety guidelines is particularly important for the proper use of this 
device. The manufacturer assumes no liability for any and all damages that can be attributed to non-compliance 
with these guidelines.

Initial Operation Safety Considerations
• Installation/Initial Operation - Perform VC80 installation in accordance with Chapter 2, Installation. 

Specifically, pay special attention to the various electrical potentials of the vehicle. Some vehicles have a 
chassis that is connected to one of the battery supply lines (DC+ or DC-), while most electrically-driven forklift 
vehicles have floating chassis, connected to neither DC+ or DC-. See Wiring Vehicle Power to the VC80 on 
page 2-4 for required wiring of vehicle power and fusing for the VC80.

• Risk of injury during transit or installation - The unit can fall during transit or installation and cause injury. 
Always ensure that there are two persons available when installing or removing the device.

• Ensure that no persons are injured in case the mounting bracket breaks - The VC80 may not be 
installed in such a way that persons can be injured during a breaking of the mounting bracket (e.g. fatigue 
break). If the device is mounted in a place where people can be injured if the bracket breaks, apply 
appropriate safety measures (e.g. install a security cable in addition to the device bracket).

Power Supply/Cable Safety
The main power cord shall comply with the national safety regulations of the country where the equipment is to be 
used.

• Operation in an emergency - In case of an emergency (such as damage to the power cable or housing, or 
ingress of liquid or other foreign bodies), disconnect the device immediately from the power supply. Contact 
technical support staff at once.

• Protection of the power supplies - If, after replacement, the fuse fed by the internal power supply blows, 
send the device for servicing immediately.

• Danger of electrocution when cleaning/servicing the device - In order to avoid electrocution, always 
disconnect the VC80 from the power supply before cleaning or servicing the device.

• Do not exceed maximum voltage when charging the vehicle battery - While charging the vehicle battery, 
disconnect the VC80 from the battery or ensure that the maximum allowed input voltage of the VC80 is not 
exceeded.

• Do not switch on devices with damaged cables or plugs - Do not use the VC80 if a cable or plug is 
damaged. Replace damage parts immediately.

• Do not connect or disconnect cables during storms - Cables must never be connected or disconnected 
during an electrical storm.

External Devices Safety
The use of additional wiring and other peripheral devices, which are not recommended or sold by the manufac-
turer, can result in fire, electrocution or personal injury.

• If a power supply is used, only use the power supply recommended by the manufacturer. 
• Before connecting or disconnecting peripheral devices (exception: USB devices), disconnect the VC80 from 

the power supply to avoid serious damage to both the VC80 and the connected devices.
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VC80 Vehicle-Mount Computer Features

Figure 1-1    VC80 Front View 

Figure 1-2    VC80 Top View
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ANT 2 - Reverse Polarity SMA Jack (WLAN + BT) / External WiFi Diversity or MIMO Antenna
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NOTE     Antenna options are dependent on the VC80 configuration. Some configurations only have internal 
antennas while other configurations have two or more external antenna connectors. WiFi antennas are 
not shipped with the VC80 and must be ordered as a separate accessory.
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Figure 1-3    VC80 Back View with Dust Cover

Figure 1-4    VC80 Back View without Dust Cover
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Front Keys and LED Indicators

The VC80 has the following front bezel keys and LEDs:

Front Keys

Table 1-1    VC80 Front Keys

Front Function

Power Keys

On/Off Button Powers the VC80 On or Off. To reset the device, press and hold the On/Off button for 
at least seven seconds until the green LED changes to amber.

Speaker/Display Speaker volume and display brightness adjustment button. Use the (-) sign to 
decrease volume/brightness and use the (+) to increase the volume/brightness. 

Keyboard Display on screen keyboard. 

Blue Modifier Key Modifies programmable macro keys allowing for an additional six programmable keys. 
Press the Blue Modifier key twice to lock the key on and to unlock, press the key once 
again.

Macro Keys
Programmable

Six programmable macro keys. When used with the Blue modifier key, six additional 
programmable keys are provided. Keys may be mapped in the Control Panel by 
assigning scancodes (see Chapter 7, Scancode Map) or macro mapping with 
My-T-Soft.

Bar Codes

Pairing Bar Code Pair peripheral Bluetooth scanners to the VC80. 

Unpairing Bar Code Unpair peripheral Bluetooth scanners to the VC80.

Speaker

Front Speaker Located on front bezel.
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LED Indicators

Table 1-2    VC80 LED Indicators

Configuring GPS 

For VC80 configurations with GPS, see GPS on page 3-31 for information on setting up and configuring the GPS 
with U-Center.

Green/Amber 
LED Red LED Blue LED Description

Off Off Off No external power and the VC80 is not running on UPS.

Amber On Off Off External power is available but the VC80 is not turned On 
(in shutdown or hibernate mode). The VC80 is ready to 
be turned on and is currently charging the UPS battery. 

Green On Off External power is available and the VC80 is turned ON. 
The UPS battery is charging. 

Green Flashing 
(50% Duty 
Cycle On at 
500ms Period)

External power is removed. The VC80 is running on UPS 
battery power. 

Green Flashing 
(25% Duty 
Cycle On at 
4000ms Period)

Off Off The VC80 is in sleep mode. 

Green On Off Off Bezel keyboard keys: M1, M2, M3, M4, M5, M6

Green On Off On Bezel keyboard keys: M7, M8, M9, M10, M11, M12

Flashing Red 
(50% Duty 
Cycle On at 
500ms 
Period)

Temperature related warning or error event in the 
system. Average of radio card and audio codec tempera-
ture readings is either <-35° C or > +65° C. No action is 
required if the OS is running. If the OS is in Sleep or 
Hibernate state, then the EC should switch the VC80 Off.

Off On Off Warm up condition. The average of radio card and audio 
codec temperature readings is between -35° C and 0° C. 
The OS is not running. The Power Button is disabled.

NOTE     For fields in the above table without LED information, the LED can be On or Off dependent on user 
actions and ambient temperature.
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Connecting External Devices

Disconnect the VC80 from the power supply before:

• Connecting or disconnecting external devices (e.g., scanner, keyboard).

• Connected to network.

Powering Up the VC80

Power up the VC80 after connecting all of the devices.

To power up the VC80, connect to an appropriate power supply and press the Power button (see Figure 1-1) or the 
ignition signal.

Powering Down the VC80

Always shut down the VC80 as follows:

1. Select Start.

2. Select Shut Down.

CAUTION Turn on external peripheral devices with power supplies at the same time or after turning on the VC80. 
Ensure that the VC80 is adequately protected from power leakage caused by an external device.

CAUTION Make sure there is a suitable disconnecting device such as a power switch or circuit breaker in the 
power supply circuit. See Installing the VC80 on page 2-2 for more information.
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Setting Up WLAN

Connecting WLAN on VC80 with Windows 7

To connect to the WLAN:

1. Click on the WiFi icon in the system tray to display available WLAN networks.

2. Click on the desired network and select Connect. 

Figure 1-5    WLAN Connection on VC80 with Win 7
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Setting Up a New Connection or Network for VC80 with Win 7

To set up a new connection or network:

1. Click on the WiFi icon in the system tray.

2. Select Open Network and Sharing Center (see Figure 1-5).

3. Select Set Up a New Connection or Network. 

Figure 1-6    Setup New Connection or Network for VC80 with Windows 7

4. Choose a connection option.

5. Follow the prompts to complete setup.



1 - 10 VC80 User Guide
Broadcom Help for Window 7

The Broadcom Help utility assists with managing the WiFi connection or network.

To access Broadcom Help: 

1. Go to Start > Control Panel > Broadcom Utility. 

2. Select the Help tab on the top tool bar. 

3. Select the desired topics for assistance. 

Figure 1-7    Broadcom Help
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Connecting WLAN on VC80 with Windows 10

To connect to the WLAN:

1. Left click on the WiFi icon in the system tray to display available WLAN networks.

2. Select the desired network and enter additional settings.

To manually connect to the WLAN: 

1. Right click on the WiFi icon for networks that do not broadcast the SSID.

Figure 1-8    WLAN Connection on VC80 with Windows 10
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Setting Up a New Connection or Network for VC80 with Windows 10

To set up a new connection or network:

1. Right click on the WiFi icon in the system tray.

2. Select Open Network and Sharing Center (see Figure 1-9).

Figure 1-9    Open Network and Sharing Center for VC80 with Windows 10

3. Select Set Up a New Connection or Network. 

Figure 1-10    Setup New Connection or Network for VC80 with Windows 10

4. Select Manually connect to a wireless network.

Figure 1-11    Manually Connect to a Wireless Network
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5. Enter wireless network information. 

Figure 1-12    Enter Wireless Network Information

6. Select Next. 

Broadcom Help for Window 10 

The Broadcom Help utility is not available for Windows 10.
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WiFiReconnectService

The WifiReconnectService is a lightweight Windows Service that is designed to run in the background on any 
VC80 (Windows 7) device. It is included in the VC Control Panel installer. The service continuously monitors the 
WiFi connection state. It attempts reconnection to the last known good SSID in the event of a disconnect, or scans 
and reconnects to any saved network with a reasonable signal strength. The software is used to counteract slow 
default reconnect performance through the native WiFi stack.

By default, the WifiReconnectService is set to Startup Type Manual (does not launch at startup). To activate the 
service, go to the Services control panel, edit the Service Properties to specify Automatic Startup, and Start the 
service.

Configuration

The WifiReconnectService exposes a limited amount of timing parameters that can be modified to further optimize 
the VC80 reconnect time. All parameters are stored in the following registry key:

[HKLM\SOFTWARE\Zebra Technologies\Wifi Reconnect Service]

The timing parameters are as follows: 

• BackoffTime - Determines the number of seconds to back off (do nothing) following a disconnect event. The 
default is 0 and the range is 0 - 60s.

• ConnectDuration - Determines the number of seconds to attempt to reconnect to the last known good SSID 
following a disconnect. The default is 9999 and the range is 0 - 9999s. If quick roaming between multiple 
SSIDs is required, set this value to 0 so that disconnection immediately activates scan mode.

• ConnectInterval - Determines the number of seconds between individual reconnect attempts during the 
ConnectDuration period. The default is 5 and the range is 3 - 300s (5 minutes).

• MinimumRssiNegative - Provides the minimum RSSI for an existing connection to be considered good. 
When a connection has a lower RSSI, the service treats it as disconnected. Registry entries are positive 
numbers and the setting is negated to get the actual RSSI. For example, setting this registry entry to 80 
means that the minimum RSSI is -80. If unset, any RSSI is considered fine. The default is Unset and the 
range is Unset, or -100 to -20.

• MinimumSignalQuality - Provides a minimum signal quality for an available network to be considered good. 
When in scanning mode, any available network with a signal quality lower than this value will be ignored. 
This is a percent. The default is 60 and the range is 1 - 100%.

• PollingInterval - Determines the interval for the main application loop, in milliseconds, to run and update the 
current connection status. A lower interval will result in better responsiveness, but will increase the CPU load. 
The default is 5000 and the range is 100 - 300000ms (5 minutes).

• ScanInterval - After the ConnectDuration value is reached, the software switches to scan mode and 
periodically launches a scan for available connections. When a connection is available for a saved profile 
that meets the minimum signal quality criteria, a connection to it is attempted. This parameter specifies the 
time interval between individual scans in seconds. A scan should take at most four seconds, according to 
Microsoft specifications. Performing frequent scans can affect the performance of the device. The default is 8 
and the range is 4 - 300s.

• VerboseMode - When set to 1, this parameter enables verbose logging to the Event Viewer (Windows > 
Application section, source WifiReconnectService). The default is 0.

NOTE The registry configuration is read and applied whenever the WifiReconnectService service starts. 
For parameter changes to take effect, a restart of the service is required.



Getting Started 1 - 15
Event Viewer

By default, some logging regarding the starting/stopping of service is routed to the Event Viewer (Windows > 
Application section, source WifiReconnectService). To verify the configuration of the WifiReconnectService, filter 
the WifiReconnectService source, and verify the parameters used.

Figure 1-13    Event Viewer

The parameters between the parenthesis correspond to the following: 

(PollingInterval, BackoffTime, ConnectDuration, ConnectInterval, ScanInterval, VerboseMode, 
MinimumRssiNegative, MinimumSignalQuality) 

Starting/Stopping Service

To halt the WifiReconnectService functionality, manually stop the service from the Services or Computer 
Management control panel. It may be restarted at any time.

Figure 1-14    Start/Stop WifiReconnectService
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CHAPTER 2  INSTALLATION
Introduction

This chapter provides instructions on installing the VC80.

Overview

The VC80 can be installed in a variety of ways: 

• Position the VC80 horizontally on a desk or mounted on a vehicle console.

• Wall mount the VC80 using the optional wall mount (see VC80 Mounting Accessories on page 6-7).

• Overhead mount on a lift truck cage using mounting hardware.

Depending on the vibration resistance and pivoting demands, mounting brackets, clamp foots or RAM mount 
elements can also be used to attach the device. Contact your Zebra sales office to find out more about the range of 
available installation options.

Mounting Instructions

Follow and retain the mounting instructions included with assembly kit when installing the VC80. See Safety on 
page 1-2 for safety instructions. 

Heater Status

The VC80 offers a unique heater system that enables continuous operations in freezer environments. See Heater 
Status for VC80 Windows 7 on page 3-19 for information about the heater settings.

WARNING! The unit could fall during transit or installation/mounting and cause injury. Always 
ensure that there are two people available when installing or removing the device.
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Installing the VC80

Electrical Installation

There are various electrical potentials when installing the unit on a vehicle such as a forklift.

Figure 2-1    VC80 Ground Lug

Most electrically driven forklift vehicles have floating chassis connected to 
neither DC+ or DC-. However, electrical faults can cause the battery + or - to be 
connected to the chassis via low resistance paths. All connected peripherals 
must be completely isolated.

The VC80 accepts DC power sources with a minimum of 10VDC nominal and 
48VDC nominal. A Power Pre-regulator is required for voltages above 48VDC 
nominal.

Applying a voltage above 48VDC nominal without the pre-regulator or reversing 
polarity may result in permanent damage to the VC80 and voids the product 
warranty.

Ground Lug

CAUTION Attach the VC80 connecting cable as close to the battery as possible. Connecting the VC80 
to large electrical loads, such as converters for the forklift motor may result in random 
restarts, malfunctions and/or irreparable damage to the device.

To connect devices fed by other power sources to the VC80, such as printers, power up the 
peripheral devices at the same time or after the VC80 to avoid start-up problems, 
malfunctions or irreparable damage to the device.
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Wiring Guidelines

The metal chassis of the VC80 is equipped with a ground lug (located on the underside adjacent to the power 
cable) to provide additional ground to the vehicle. It is strongly recommended that a grounding strap is used to 
connect the ground stud on the vehicle-mount to a solid, reliable contact point on the main portion of the vehicle 
chassis. It must not be connected to battery negative or terminal block. 

As with other vehicle cables, carefully consider the routing of the ground strap to ensure it does not pose a hazard 
to the operator or the safe operation of the vehicle. If necessary, secure the ground strap with cable ties or some 
other mechanical means to prevent loops or loose lengths of wire from catching on stationary items when the 
vehicle is in motion. 

Before installing the cables between the mount and other devices, consider the following:

• Ensure that drilling holes do not damage the vehicle or its wiring.

• Protect cable runs from pinching, overheating and physical damage.

• Use grommets to protect cables that pass through metal.

• Use plastic straps and tie-downs to secure cables and connectors in their desired location, away from areas 
where they may get snagged or pulled.

• Keep cables away from heat sources, grease, battery acid and other potential hazards.

• Keep cables away from control pedals and other moving parts that may damage the cables or interfere with the 
operation of the vehicle.

IMPORTANT Make sure the cables run inside the roll cage of the vehicle.

If the VC80 is installed in an environment where earth ground is present such as a vehicle 
with metal wheels running on a metal track, or is powered by the AC/DC adaptor in a 
permanent installation, the ground lug must be connected to the ground structure.
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Wiring Vehicle Power to the VC80

An extension power cable is used to wire the VC80 to the truck battery (order cable separately, see Accessories on 
page 6-1). Wire this cable to a filtered, fused (15A max) accessory supply on the vehicle. Follow the installation 
instructions supplied with the extension cable. 

Additional wiring (minimum 14 gauge), connectors or disconnects used should be rated for at least 300 VDC, 15A.

When connecting the extension power cable:

• If a power extension cable with ignition sense is used, ensure that the ignition sense wires (18AWG wires in 
red and black leads) and the power wires (14AWG in red and black leads) are reliably secured away from 
each other, or are separated with reliably secured certified insulation. Minimum 2.8 mm distance, or 0.4mm 
distance through insulation is required for the separation.

• The red lead of the 14AWG power cables attach to the vehicles battery positive terminal. The 14AWG black 
lead connects to the vehicle’s battery negative terminal. This should be connected to a proper terminal block 
and not to the vehicle body. An optional grounding strap wire (sourced separately) may be connected to the 
ground lug of the VC80 terminal connector bay and to the vehicle chassis.

• You may have the option to connect power before or after the key switch. Though the VC80 is equipped with 
a UPS, a proper shut down is recommended using the windows shut down procedure. If it is wired after the 
key switch, the operator must shut down the VC80 using the Windows shut down procedure before turning 
off the vehicle. If it is wired before the key switch, then to avoid excessive drain on the vehicle battery, either 
the operator should shut it down when the vehicle is to be left off for an extended period, or the ignition cable 
shut down wire should be connected and the VC80 configured to shut down automatically. 

• An appropriate fuse type must be used with the power extension cable according to the installation 
instructions. For main power cable, use 3AB, 15A, 250V, slow blow fuse. For ignition sense input, use 3AB, 
0.3A, 250V, slow blow fuse.

WARNING Applying voltage above the input voltage rating or reversing polarity may result 
in permanent damage to the VC80 and void the product warranty.

NOTE The VC80 supports the ignition sense feature that detects when the ignition switch or key 
switch is On or Off to allow automatic computer start up or shut down (with delay as needed). 

When wiring the ignition sense wires (18AWG in red and black), the red 18AWG wire is 
connected to a positive DC voltage source switched on by the ignition. The black 18AWG wire 
is connected to ground reference of this switched ignition source.
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Positioning the VC80 in the Vehicle

When positioning the VC80 on the vehicle: 

• The driver's field of view must be kept free.

• Plan for sufficient space if a keyboard and scanner are installed with the VC80.

• No part of the VC80 system may project beyond the vehicle.

Overview of the Assembly Steps

Before fastening the VC80 to the vehicle:

• Configure shut down automation.

• Prepare the forklift such as ignition connection and correct voltage.

• It is recommended to fasten the bracket to the vehicle and then install the VC80 to the bracket.

Cable Dust Cover 

For the dust cover location, see VC80 Back View with Dust Cover on page 1-4.

Strain Relief

After the VC80 and bracket are fastened, prepare the strain relief as follows: 

1. Install the cables loosely on the strain relief rail (see Figure 1-4 on page 1-4).

2. As far as possible, route cables leading to or away from the unit next to one another without crossing.

3. Fasten the cables into the strain relief rail precisely at the positions at which the cable openings in the cable 
cover are located.

CAUTION Turn on external peripheral devices with their own power supply at the same time or after the VC80. If 
this is not possible, ensure that the VC80 is adequately protected from power leakage caused by an 
external device.

CAUTION For safety reasons, install the supplied cable cover for the external ports prior to using the VC80.
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Installing the VC80 on a Forklift

1. Attach the desired mount to the VC80. Refer to the VC80 User Guide at www.zebra.com/support for detailed 
mounting options and instructions.

2. Attach the mounted VC80 to the vehicle and position in a location that does not obstruct the operator’s view.

3. If using an external antenna, connect antenna in a vertical position to the VC80.

4. Connect peripherals to the VC80. Place the cables in the strain relief brackets inside the dust cover and replace 
the dust cover (see Figure 1-3 on page 1-4).

5. Connect the VC80 to the vehicle DC supply. 

6. Press the Power button to turn the device On or Off (see Figure 1-1 on page 1-3). 

Figure 2-2    View Obstruction Considerations

CAUTION Tighten peripherals with thumbscrews by hand only. Do not use tools for tightening thumbscrews.

NOTE If installing peripherals, allow enough space when selecting a mounting location.

View Obstruction Considerations

http://www.zebra.com/support  
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Forklift Battery Replacement Conditions

The VC80 maintains normal function of applications and connections during and after forklift battery replacement. 

Replace the forklift battery at any point during a shift and/or while the VC80 is fully running.

The forklift battery may be replaced under following condition: VMC external temperature range: -30° C to +50° C. 

During forklift battery replacement (VMC is running on UPS battery), both Windows and the VC80 are monitoring 
remaining UPS battery capacity. The default Low Battery notification threshold is set to 20% for all Windows Power 
plans. The Critical Battery threshold is set to 10%. If UPS battery is discharged below 10%, the VC80 automatically 
shuts down. 

An additional notification message can be enabled in the VC80 with a threshold set to the configured Low Battery 
level plus an additional 10%. If enabled, this message appears to the User when the UPS battery is discharged to 
30% (20% + 10%) level.

Starting from Cold Soak

The VC80 does not startup from a saturated cold soak when internal VC80 temperature (critical components and 
UPS battery) is below -30° C or UPS battery has less than 10% capacity. The red LED warning indicator may 
display.

The VC80 can to start up from a saturated cold soak at -30° C (or above) internal VC80 temperature when a valid 
external DC power source is present.

The VC80 design minimizes wait time from -30° C cold soak to load the OS and have internal heaters to assist 
system warm up.

From a -30° C cold soak condition, the VC80 battery heater may be activated to warm the UPS battery to an 
acceptable charging temperature if charging is needed. The conditions and time to heat the battery are managed 
by the system. The OS load time and VC80 ready for use time is independent of warming the battery.
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Installing the Power Pre-Regulator

To install the power pre-regulator: 

1. Attach the pre-regulator cable male connector to the Zebra power extension cable which is installed on the 
vehicle.

2. Connect the pre-regulator cable female connector either directly to the VC80 power cable, or to the power 
extension cable. See Figure 2-3.

Figure 2-3    Connections To Vehicle DC Supply 

Non-Vehicle Installations

Using AC power, the VC80 Vehicle-Mount Computer can be mounted at fixed locations adjacent to cross-dock 
doors, manufacturing stations, or in offices.

Use the 100/240 VAC Power Supply (p/n PS000145A01) to power the computer from an AC source. 

IMPORTANT The Zebra power extension cable positive lead is red and the negative lead is black.

It is recommended that all connections be secured with electrical tape or heat shrink to 
prevent contaminants from degrading the connection. 

Without Power Pre-regulator
For vehicles with DC power 48V or less 

With Power Pre-regulator
For vehicles with DC power greater than 48V

M1
M7

M2
M8

M3
M9

M4
M10

M5
M11

M6
M12

M1
M7

M2
M8

M3
M9

M4
M10

M5
M11

M6
M12

 Power Extension 
without Ignition Sense (p/n CA1210)

Power Extension
without Ignition Sense

(p/n CA1210)

Power Extension
with Ignition Sense

(p/n CA1220)

Power Extension
for Pre-regulator with

Ignition Sense
(p/n CA1230)

IMPORTANT The AC/DC power supply is only intended for use at room temperature condition such as 
an office environment.
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Power On/Off with Ignition 

The VC80 is equipped with an ignition sense feature which puts the terminal into suspend/shutdown when the 
vehicle ignition is turned off and can power on the terminal when the ignition is switched on. To use this feature, a 
power extension cable with ignition sense wires must be used and installed properly on the vehicle. 

The cable in Figure 2-4 is the power extension cable (p/n CA1220) with two wires used to connect to vehicle igni-
tion. The red and black leads of the two 18AWG wires that connect to the key switch of the ignition and ground, 
respectively. Once the wires are connected, the VC80 may switch on or off depending on the state of the vehicle 
ignition key. See Power for VC80 Windows 7 on page 3-20 to select power settings.

Figure 2-4    Power Extension Cable Kit with Optional Ignition Sense Wires (p/n CA1220) 

IMPORTANT When connecting to an ignition switch using the power extension cable with ignition sense 
wires, ensure that the wires of different polarities are reliably secured away from each 
other, or are separated with reliably secured certified insulation. A minimum distance of 
2.8mm (or 0.4mm distance through insulation) is required for the separation. 

The thinner wires (18 AWG) are used for Ignition Sense wires while the thicker wires 
(14AWG) are used for Vehicle Power and Ground. Identify them carefully and 
Do Not confuse them. 

An appropriate fuse type must be used with the power extension cable according to the 
installation instructions. For the main power cable, use 3AB, 15A, 250V, slow blow fuse. 
For ignition sense input, use 3AB, 0.3A, 250V, slow blow fuse.
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Screen Blanking Wiring

Connecting Switch for Screen Blanking

To use Screen Blanking, connect one of the two DB9 serial ports (using CA1300 Screen Blanking cable) on the 
VC80 to a switch. Activate this switch electrically (e.g. motion sensor, GPS) or mechanically (e.g. pedal switch) 
when the vehicle is in motion.

Figure 2-5    Connecting the Switch to the DB9 Cable

The screen blanking feature makes use of either one of the DB-9 ports to monitor electrical relay closure. When 
enabled, the CTS/RTS pins of the DB9 port are continuously monitored by the screen blanking application. See 
Figure 2-6 for pin configuration.

When the vehicle is in motion, the switch closes the circuit, allowing data packets to be sent or received through the 
RTS and CTS pins. The computer detects that the circuit is closed and turns off the screen.

When the vehicle is not in motion, the switch opens the circuit, preventing data packets from being sent or 
received. The computer detects that the circuit is open and turns on the screen. 

Figure 2-6    Screen Blanking DB9 Pin Configuration

IMPORTANT For customers migrating to the VC80 from a 8515, 8525, 8535 vehicle mount computer or 
a 753x hand-held computer cradle:

If the screen blanking feature was used previously, ensure that you are no longer feeding 
the screen blanking signals to the VC80 main DC power cable. Rewire the screen 
blanking inputs to the VC80 DB-9 serial port through the DB-9 screen blanking cable. In 
previous generations of vehicle-mount computers, the screen blanking signals were fed in 
to the terminal through 2 of the 4 wires in the CPC connector of the DC power cable. This 
no longer applies for the VC80.



CHAPTER 3 SOFTWARE WINDOWS 7
Introduction

This chapter provides software information and instruction for the VC80 with Window 7.

Microsoft Windows Setup and Configuration

After the system files are processed, Microsoft Windows loads. Standard Windows configuration options apply to 
the VC80. Configuration options are located in the System Tray or the Control Panel. For example, use the System 
Tray to adjust the time, date or volume level and the Control Panel to add, delete or modify software. 

Folder Structure

Microsoft Windows is installed in the \Windows folder. For information on the folder structure, refer to the 
commercially available Microsoft Windows OS Reference Guide.
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VC80 Windows 7 Software Components

The VC80 contains the following software components:

• BIOS

• Embedded Controller firmware

• Microsoft Operating System (Windows 7 Standard or Professional).

• VC Control Panel

The following Windows OS features are unique to the VC80 (dependent on configuration):

• Touch driver

• WLAN/Bluetooth driver

• Ethernet driver 

• GPS

• Zebra printer tools and drivers.

The Embedded Controller manages communication with the following VC80 unique features:

• Heaters

• Battery state

• Data logging.

VC80 Windows 7 Without Operating System

The VC80 can be ordered with no operating system. This configuration requires the following:

• Windows 7 installation media

• A valid product licensing key.

When prompted for driver locations during installation and setup, direct the device wizard to the USB drive. 

• For Windows 7 drivers, go to: www.zebra.com/support.

http://www.zebra.com/support 
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Connecting VC80 Windows 7 to Terminal Emulation

The VC80 supports terminal emulators such as TekTerm. For connection to a host, have the following information 
available: 

• Alias name or IP host address

• Port number of the host system 

• Emulation.

To connect to a host: 

1. Ensure the mobile client network settings are correctly configured.

2. Ensure the VC80 is connected to the network if connecting via WLAN.

3. Launch the terminal emulation application. 

TekTerm 

TekTerm is a powerful terminal emulation software application with the ability to interface with multiple Bluetooth 
and serial scanners. TekTerm is pre-licensed and pre-installed on the VC80.

It is recommended to check the latest TekTerm version released for the VC80. For more information regarding 
TekTerm, go to: www.zebra.com/support.


http://www.zebra.com/support.
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VC80 Windows 7 Bar Code Scanners and Settings

The VC80 supports the following types of bar code scanners:

• Tethered scanner connected to COM1 or COM2.

• Tethered scanner connected to a USB host port

• Wireless scanner connected via Bluetooth.

Serial Scanners for VC80 Windows 7

To configure serial scanners:

1. Open the VC Control Panel and select Power.

2. Enable the power to the port.

Figure 3-1    Enable Power for Serial Scanners (VC80 with Windows 7)
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3. Select TekWedge and select Enable TekWedge to support serial scanners. 

4. Under Properties, make the following selections:

• Enable Good Scan Beep - When enabled, a beep sounds upon a successful decode. When disabled, a 
beep does not sound upon a successful decode. 

• Ignore Caps Lock and Shift - When enabled, the state of Caps Lock and Shift keys do not affect the data 
received from the scanner. When disabled, the scanner data may be converted to upper/lower case based 
on the current state of the Caps Lock and Shift Keys. 

5. Select Config Ports.

Figure 3-2    Enable TekWedge for Serial Scanners

6. Select the new COM port and select Enable Port. 

Figure 3-3    Enable Port for Serial Scanner (VC80 with Windows 7)

7. Select OK.
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USB Scanners for VC80 Windows 7

The Windows OS loads a USB driver for USB scanners. USB scanners are not controlled or managed by 
TekWedge therefore, post processing such as translation rules can not be used with USB scanners. 123Scan2 can 
be used to create rules and download to the scanner. 

To configure USB scanners, connect the scanner to the VC80 USB port and follow the scanner setup instructions. 
For Zebra scanner guides, go to: www.zebra.com/support.

Bluetooth Scanners for VC80 Windows 7

See Quick Setup for VC80 Windows 7 on page 3-10 for information on connecting Bluetooth scanners. Always use 
TekWedge for VC80 Windows 7 on page 3-24 to configure Bluetooth parameters. 

Pairing Bluetooth Scanners Using Bar Codes for VC80 Windows 7

To pair Bluetooth scanners using bar codes: 

1. Select Bluetooth > Open Settings to access Bluetooth settings.

Figure 3-4    Open Settings (VC80 with Windows 7)

NOTE If the Bluetooth scanner connection to the VC80 is lost, it is recommended to first scan the Unpair bar code 
and then scan the Pair bar code. 

http:// www.zebra.com/support.
http:// www.zebra.com/support.
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2. In the Options tab, select check boxes under Discovery and Connections. 

Figure 3-5    Bluetooth Discovery and Connections (VC80 with Windows 7)

3. In the COM Ports tab, select Add. 

4. Select the radio button Incoming (device initiates the connection).

5. Select OK.

Figure 3-6    Add Incoming Bluetooth Devices (VC80 with Windows 7)
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6. Open the VC Control Panel and select TekWedge. 

7. Enable TekWedge. 

8. Select Config Ports.

Figure 3-7    Enable TekWedge (VC80 with Windows 7)

9. Select the new COM port and select Enable Port. 

Figure 3-8    Enable COM Port for Bluetooth Device (VC80 with Windows 7)

10. Select OK.

11. Scan the bar code to pair the scanner (the scanner must be configured for SPP mode). 
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Settings for VC80 Windows 7

Select Start Menu > Admin Tools > VC Control Panel to configure the following VC80 settings:

• Quick Setup

• Bezel Keypad

• Haptics Feedback

• Heater Status

• Power

• Push to Talk

• Screen Blanking

• System Info

• TekWedge

• UPS Battery 

• Data Logging

Figure 3-9    VC80 Settings (VC80 with Windows 7)
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Quick Setup for VC80 Windows 7

Select Start Menu > VC Control Panel > Quick Setup to configure the following quick setup options. 

Links to Microsoft or third party utilities: 

• Touch Panel Calibration - Calibrate the touch panel.

• WLAN Configuration - Configure WLAN. 

• Network Configuration - Configure network parameters such as, Static IP address and DHCP.

• On-Screen Keyboard Configuration - My-T-Soft Keyboard configuration. 

VC80 control panel: 

• Manage VC Configuration - Load or save configuration files.

Figure 3-10    Quick Setup Settings (VC80 with Windows 7)
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Touch Panel Calibration for VC80 Windows 7

Hardware 

Associates the pointer device with the monitor/desktop area that is controlled by the device and shows the 
hardware port information. 

• Handling Whole Desktop - Whole indicates the primary monitor. 
• Connected to USB Port - Displays the port connected to the device.
• Add a New Device - Option to add a device. Only non USB devices are manually added. USB devices 

are automatically added. 
• Remove this Device - Option to remove a device. Only non USB or inactive USB are manually 

removed.

Figure 3-11    Hardware Settings (VC80 with Windows 7)

NOTE Select Help for detailed information on the Touch Panel Calibration options. 



3 - 12 VC80 User Guide
Click Mode

• Interactive Touch - Shows the current click mode emulation for a single touch. The setting is only 
active if the driver is responsible for the pointer handling via the standard mouse interface into the OS. 

• Extended Touch - Vista and above, UPDD can deliver touch co-ordinate data to the Windows OS via 
three interfaces: mouse class, HID class, Win8TI API interface. 

• Visual Notification - Indicates if visual feedback is shown during Interactive Touch right click 
countdown. 

• Interactive Switch Delay - Select the delay pace.

• Sound Options - Configure touch sound options. 

• System Mouse Settings - Adjust the mouse pointer settings defined within the OS. 

• Test Icons - Test Right Click and Double Click. A tick is shown if the click test is successful.

Figure 3-12    Click Mode Settings (VC80 with Windows 7)
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Properties 

• Name - Associates a name to the device. By default the name is the drivers controller device name. 

• Low Pass Filter - Applies a filter to produce a smoother drawing. The speed of drawing is affected, the 
higher the value used. 

• Liftoff Time - Specifies the time interval required to register a stylus lift after the last touch packet is 
received. Lift off time is defined in units of 10ms. 

• Stabilization - Causes small movements to be ignored.

• Averaging - Applies a filter to produce smoother drawings. Filtering can improve drawing without 
affecting the drawing speed. 

• Mode - In a multi pointer device environment, this setting indicates the priority given to the device. With 
the Interlock option, the device can only be used if no other device is in use. The Admin option allows 
any device currently in used to be forced into a pen up state and the device is given immediate priority. 

• Release Time - Defines the interlock release times. 

• Use Lift-off Packet - Only shown if a pen up data packet is generated by the device on stylus lift off. 

• Anchor Mouse - If the device generates a pen up data packet on stylus lift, the mouse cursor returns 
to its original position after using the pointer device. 

• Enabled - Indicates if the device is enabled. This is an option to free up resources without uninstalling 
the driver. 

• Advanced - Includes advanced features such as, Edge Acceleration, Ignore Touches Outside 
Calibrated Area, Support for New Events, and Portrait Rotation.

Figure 3-13    Properties Settings (VC80 with Windows 7)
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Calibration 

• Style - Invoke Calibration styles manually, from an application, a toolbar, or a command line interface. 

• Add a New Style - Add a new calibration style. 

• Number of Points - The number of calibration points determines the calibration pattern used. It is 
highly recommended that four or more points are used for greater flexibility. 

• Margin % - The percentage margin from the edge of the visual display area from which to draw the 
calibration points. 

• Timeout (secs) - Specifies the number of seconds to wait for a calibration touch before canceling the 
calibration procedure. 

• Use Eeprom Storage - Store calibration data in the controllers Eeprom.

• Confirm After Calibration - Select to use new calibration data. 

• Sound Options - Calibration sound options. 

• Calibrate - Invoke calibration procedure for the current device. When calibrating for the first time in a 
multi-monitor environment, calibrating the devices also sets up desktop/touch device relationships.

Figure 3-14    Calibration Settings (VC80 with Windows 7)
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Status 

• Controller Type - The actual controller type in use irrespective of the name given to it in the UPDD 
console. 

• State - Indicates if the device is enabled at the UPDD level. 

• Macro Result - Shows if a controller is initialized by the driver. 

• Replay Initialization Macro - Reinitializes the controller. The macro, if defined, is sent to the controller. 

• Reset Error Counts - Reset the sync error count. Only enabled if error count > 0. 

• Reload Driver Settings - Reload the driver. 

• Show Test Screen - Invoke the test utility. 

• Show Test Grid - Invoke the test utility with drawing grid. 

• Dump Settings - Dump driver settings to a file. The file is useful for support purposes but can also be 
used in subsequent installs to define the initial settings.

Figure 3-15    Status Settings (VC80 with Windows 7)
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Manage VC Configuration for VC80 Windows 7

• Import - Load VC configuration from file.

• Export - Export VC configuration to file.

• Restore Default - Sets all parameters to factory default.

Figure 3-16    Manage VC Configuration (VC80 with Windows 7)
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Bezel Keyboard for VC80 Windows 7

• My-T-Soft Macro Mapping - Allows remapping and/or assigning various custom functions to the Bezel 
buttons. 

• Assign Bezel Key Scancodes - Map bezel keys one of the following ways: 

• Bezel Key - Assign bezel key using the drop-down menu. 

• Assign Scancodes - Assign scancode function from drop-down menu. To change scancodes to assign 
unique functions/characters, see Chapter 7, Scancode Map. 

• Blue Key

• One-Shot -Activates the Blue key function on the first key press and remains activated until any key is 
pressed again. 

• Lock - Activates the Blue key function on the first key press and remains activated until the Blue key is 
pressed again. 

• One-Shot/Lock - Activates the Blue key function on the first key press. The second Blue key press locks 
the Blue key function. The third Blue key press deactivates the function. 

Figure 3-17    Bezel Keyboard Settings (VC80 with Windows 7)



3 - 18 VC80 User Guide
Haptic Feedback for VC80 Windows 7

• Haptics Feedback 

• Enable/disable Haptics Feedback. 

• Select Full Screen or My-T-Soft Only.

• Parameters 

• Select the haptics waveform type: Long Double Sharp Click Waveform or Strong Click Waveform.

• Select the haptics waveform level.

Figure 3-18    Haptics Feedback Settings (VC80 with Windows 7)
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Heater Status for VC80 Windows 7

The VC80 heater ensures optimum performance in freezers. The heater benefits include: 

• Touch screen heater clears condensation on the display.

• Port heater prevents condensation on contacts.

• Audio Codec, UPS Battery and WLAN/BT radio require heaters to operate below freezing temperatures.

• The user interface displays current temperatures.

Heater Status settings: 

• Current Temperature - Displays internal and external temperatures. 

• Display Temperature - Select desired temperature scale.

• Temperature Status

• Green LED - Heater is enabled.

• Red LED - Heater is disabled.

• Start Test - Verifies heater operation when temperature increases. 

Figure 3-19    Heater Status Settings (VC80 with Windows 7)
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Power for VC80 Windows 7

• Interface Power Configuration - Enable/disable power for serial and USB ports. 

• Vehicle Ignition Detection 

• Start VC when vehicle ignition changes from OFF to ON state. 

• Shut down VC when vehicle ignition changes from ON to OFF state.

• Enter desired minutes to delay in the Delay field. 

Figure 3-20    Power Settings (VC80 with Windows 7)

NOTE Ignition detect requires a CA1220 power extension cable. 

NOTE To configure a serial scanner, turn on the power to the port and in TekWedge settings, enable 
the port and TekWedge (seeTekWedge for VC80 Windows 7 on page 3-24).
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Push To Talk for VC80 Windows 7

• Connection Status - Displays the current connection status.

• PTT Handset Scan Code - Scan code for bezel key setting.

• Speaker - Enable the Bezel Speaker or PTT Handset Speaker.

Figure 3-21    Push To Talk Settings (VC80 with Windows 7)
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Screen Blanking for VC80 Windows 7

The optional Screen Blanking setting turns the screen off when the vehicle is moving and back on when the vehicle 
is stopped. 

• Screen Blanking - Enable/disable screen blanking feature. 

• Delay

• Blanking the VC Screen - Screen blanking duration in seconds.

• Re-Enabling the VC Screen - Re-enable screen duration in seconds.

• Blank Screen Based On 

• Com Port 1 or Com Port 2.

• Blank screen when port pins are connected - Select blank screen option. De-select to disconnect the 
blank screen option.

Figure 3-22    Screen Blanking Screen (VC80 with Windows 7)

NOTE To use Screen Blanking, first connect one of the two DB9 serial ports on the VC80 to a user-supplied 
switch or relay. See Connecting Switch for Screen Blanking on page 2-10.
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System Info for VC80 Windows 7

The System Info screen provides information about the system such as the Serial Number, OS Details, and SKU 
Detail. The system information is required for technical support inquiries. 

To export the system information to a text file:

1. Select Save. 

2. Select a location to save the file to. 

3. Name the file in the File Name field.

4. Select a file type from the Save As Type drop-down menu.

Figure 3-23    System Information (VC80 with Windows 7)
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TekWedge for VC80 Windows 7

TekWedge provides the ability to interface with Serial and Bluetooth scanners. 

• TekWedge to support serial scanners - Enable/disable TekWedge support for serial and Bluetooth 
scanners. 

• Properties 

• Enable Good Scan Beep - VC80 beeps when data is received from the scanner. 

• Code Page - Select code page from drop-down menu.

• Data Transmission - Select one type of data transmission.

• Copy/Paste (Application supports Ctrl-V) - Copy/Paste is efficient for large amounts of scanned data. 

• Keyboard Wedge.

• Ports and Translation Rules 

Figure 3-24    TekWedge Settings (VC80 with Windows 7)

NOTE To configure a serial scanner, turn on the power to the port (see Power for VC80 Windows 7 on 
page 3-20) and in TekWedge settings, enable the port and TekWedge.
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• Config Ports - Select the COM Port from the ports window and adjust the port settings such as Baud 
Rate, Data Bits, Parity, Flow Control, Stop Bits, and Timeout as desired. 

• Set to Default - Sets the default for the selected COM port. 

• Clear Unavailable Ports - Clears unavailable ports such as ports that are no longer active.

Figure 3-25    Config Ports (VC80 with Windows 7)

NOTE For large bar codes, adjust the Timeout duration. The longer the timeout, the slower the scans. 
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• Config Translation Rules - Allows you to define up to 10 cases, each consisting of up to 10 rules in 
sequential order. Only one case is applied to a bar code and a case is applied if all rules specified in the 
case are successful. If a rule within a case fails, the entire case fails.

• Case Rules -The case rules are defined as follows:

• No Rule
• Verify Barcode Size — Verifies the barcode size. Assign this rule first, before creating subsequent 

rules.
• Match at Index — Matches the match string at a specified index.
• Add Barcode Prefix/Suffix — Adds a global prefix or suffix.
• Search and Replace — Replaces all instances of the match string.
• Match and Replace at Index — Matches the match string at a specified index and replaces/changes 

it.
• Replace at Index — Replaces/changes unspecified data in a given range.

Translation information about the status of each case/rule is displayed in the scan log file. This is useful to 
determine why a rule is failing.

Select a Case/Rule to modify and then select the Scan Type drop-down menu to apply a rule.

Figure 3-26    Translation Rules (VC80 with Windows 7)
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UPS Battery Status for VC80 Windows 7

• Information - Displays the current battery information such as the Serial Number, Manufacture Date, and 
Remaining Battery Life. 

• Notification - Enable/disable Low Battery Notifications and enter a Threshold percentage for low battery 
life warnings. 

Figure 3-27    UPS Battery Settings (VC80 with Windows 7)
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Data Logging for VC80 Windows 7

Data Logging logs information about VC80 custom features.

• Log Information Level

• Source - Select a source from the drop-down menu such as Heaters, Haptics, UPS Battery.

• Content - Select a priority level from the drop-down menu such a Critical, Major, Minor. 

• Disable All Logging - Removes logging VC80 custom feature information. 

• Log File Management - Select a Log File Location, quantity of log files in the Create up to field, and disk 
size (default is 2 MB) in the Total Size On Disk field. 

Figure 3-28    Data Logging Settings (VC80 with Windows 7)

NOTE Application crash dump files are captured and stored in a restricted folder permitted for 
Administrators only (C:\VC\Logs or C:\Windows\MiniDmp).
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My-T-Soft

My-T-Soft offers a database of existing keyboard layouts for screen keyboard customization and key mapping. 
Each VC80 has access to a Zebra account on the Build a Board website for keyboard layouts. Unique custom 
keyboard layouts may be acquired for additional license fee(s). 

To access My-T-Soft, go to: www.build-a-board.com. 

Figure 3-29    My-T-Soft Screen Keyboard Layout Examples

www.build-a-board.com
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All VC80s are My-T-Soft licensed through a common account which is only available from the VC80.

To access My-T-Soft: 

1. Select Start > Select My-T-Soft > Licensing Information.

Figure 3-30    My-T-Soft License Information

2. The UAC window displays. Select Yes.

3. In the IMG License Manager menu, select Go to My Build-A-Board.com Account.

Figure 3-31    IMG License Manager

4. The Zebra account web page displays. Download existing keyboards or create your own and save in the Zebra 
account. 

NOTE To create a private collection of keyboards, you must acquire your own account. 
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Windows Management Instrumentation

Windows Management Instrumentation (WMI) is a free component of the Microsoft Windows® operating system 
that provides a scalable system management infrastructure. Using a free provider plug-in from Zebra, WMI 
enables local and network remote management of scanner(s). System administrators can leverage WMI to query 
and set information on desktop systems, applications, networks, components, and accessories, such as a scanner.

For more WMI information, go to:
• https://msdn.microsoft.com/en-us/library/aa384642(v=vs.85).aspx
• http://www.zebra.com/support

GPS

U-Center is used to set up GPS on the VC80. 

To set up the GPS:

1. Ensure that the antenna is properly installed on the GPS port (see Figure 1-2 on page 1-3).

2. Open U-Center by selecting Start > Program Files > U-Center.

3. Ensure that the receiver is connected. See Figure 1-2 on page 1-3. After approximately thirty seconds, some of 
signals bars turn to green. This signifies that the GPS has obtained 3D lock. 

Figure 3-32    U-Center Connection

COM Port Connection

https://msdn.microsoft.com/en-us/library/aa384642(v=vs.85).aspx
http://www.zebra.com/support
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Satellite Level

To view the Satellite Level, select View > Docking Windows > Satellite Level.

Location Coordinates

To view Location Coordinates, select View > Docking Windows > Data.

Figure 3-33    Location Coordinates

U-Center Software

• For detailed U-Center information, refer to the U-Center User Guide at:
https://www.u-blox.com/sites/default/files/u-center_UserGuide_%28UBX-13005250%29.pdf

• Other applications/software such as Visual GPS can be used to collect location data by communicating with 
the GPS receiver.

https://www.u-blox.com/sites/default/files/u-center_UserGuide_%28UBX-13005250%29.pdf
https://www.u-blox.com/sites/default/files/u-center_UserGuide_%28UBX-13005250%29.pdf
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Kiosk

The Kiosk application provides a simple lock-down mode for the Zebra VC80 and ET5X products. When activated, 
the standard Windows shell is replaced so that device usage is restricted to a desired application such as, a 
browser or custom workplace application.

The Kiosk app is included in the VC Control Panel installer. It is installed and uninstalled from the VC Control 
Panel. Access to Kiosk is from an icon located on the desktop.

Configuration and Activation of Kiosk Mode

Run the application directly using Start/Run… or by launching it from Windows Explorer. The path location is:

C:\Program Files\VCControlPanel\Kiosk.exe

The application requests administrative privileges to make the necessary changes to activate kiosk mode. Once 
logged in as Admin, the Configuration & Launcher window displays. Each section of the configuration window is 
detailed as follows: 

Shell Settings

Under Shell Settings, click on Browse and select the application to be executed instead of the Windows interface. 
In the Figure 3-34 example, Internet Explorer is configured. You may choose any application you desire to be the 
main application for Kiosk Mode.

Figure 3-34    Kiosk Shell Settings 

The Shell Settings options provide enhanced control for the look and behavior of the selected application.

• Application - Locate the application to launch using the Browse button.

• Remove Menu Bar - Start the application without the menu bar.

• Remove Title Bar - Start the application without the title bar.

• Auto Relaunch on Close - If the application is closed by the user, it starts again automatically.

• Maintain Focus - Maintain the focus as the top most application launched by Kiosk.
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Security

Located under Security, click on the Select Exit Key drop-down arrow to choose one of the following key 
combinations to be used to exit kiosk mode: CTRL+ALT+Q or CTRL+ALT+L. 

When the exit kiosk mode key combinations are pressed, a window displays to Log Out or Exit kiosk mode. For 
both of these actions, you may require a password to be entered by selecting the Require Admin Password 
check box and entering a password in the Password field.

Exiting Kiosk Mode requires administrative privileges and must be done from an administrative account or by 
providing administrator credentials. The kiosk password is used to prevent unauthorized logging out.

Figure 3-35    Kiosk Security Settings 

Lockdown

The task manager allows any application to run and be controlled manually which defeats the purpose of kiosk 
mode. After testing kiosk mode, it is recommended to select the Disable Task Manager check box for production 
use to prevent the task manager from being activated (for example, by selecting Ctrl-Alt-Delete).

Figure 3-36    Kiosk Lockdown

Monitor Utility

When kiosk mode is enabled, it displays icons that shows the Wi-Fi (WLAN) status and battery status. You can set 
preferences as follows: 

• Enable Monitor - Display the signal strength (RSSI dbm).

• Default Location - Select a location to display the icons: Top Left, Top Right, Bottom Left, Bottom Right. 
Select the Fixed check box to lock the location. 

• Color Mode - Select the drop-down menu to choose a background color: Black, White, or Transparent.

• Show SSID - Select to check box to display the current access point SSID

• Show Battery Level- Display the charge level of the battery as a capacity percentage.

You can try the settings without going into kiosk mode by saving the configuration, select Apply config, and 
running the monitor application manually. There is no exit button. The monitor application must be closed from the 
Task Manager manually. The monitor application is located at:
C:\Program Files\VCControlPanel\WiFiMonitor.exe

Figure 3-37    Kiosk Monitor Utility
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Additional Software

• Launch SIP - Start the My-T-Soft on-screen keyboard when the kiosk starts. An on-screen keyboard or a 
physical keyboard is necessary to exit kiosk mode.

• Enable TekWedge - Start TekWedge when the kiosk starts. This software causes scanned bar codes to be 
treated as keyboard input.

• Enable Bluetooth - Start the WIDCOMM Bluetooth software when the kiosk starts to allow pairing (for 
example, Bluetooth devices).

• Launch Custom - To specify another custom application to start up when the kiosk starts, select the Launch 
Custom check box. Select Browse to choose the desired executable. This application is in addition to the 
app configured under Shell Settings.

Figure 3-38    Additional Software

Completing Setup
Select Apply Config to save your configuration settings.

To launch kiosk mode, select Launch Kiosk to log out and launch Kiosk mode. You need your exit key and kiosk 
password. 

Kiosk settings are applied to the computer and then you are logged off. Kiosk mode is now active and applies to all 
accounts. Upon login, the configured kiosk applications run.

Figure 3-39    Completing Kiosk Setup

Exiting Kiosk Mode 
To log off or exit kiosk mode:

1. Press the key combination (see Security on page 3-34) to access the Kiosk Control.

2. If security was configured to require a password, enter your password for both of the following actions.

• Log Off - Logs off of the account to exit all open applications.

• Exit Kiosk - Deactivates kiosk mode. Administrative privileges are required. Accept the 
Run-as-Administrator request and supply administrative account credentials if exiting from a 
non-administrative account. Kiosk settings are removed from the computer and you are logged off. Kiosk 
mode is no longer active for any account. Upon login, the Windows shell runs.

Figure 3-40    Exit Kiosk Mode
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Launching Applications without UAC Prompt

To launch applications without the UAC prompt:

1. Find the installation path of the application (for example, C:\Program Files\ApplicationName) and right click on 
the application EXE file.

2. Select Properties.

3. Select the Compatibility Tab.

4. Check the option Run this Program as an Administrator.



CHAPTER 4 SOFTWARE WINDOWS 10
Introduction

This chapter provides software information and instruction for the VC80 with Windows 10.

Microsoft Windows Setup and Configuration

After the system files are processed, Microsoft Windows loads. Standard Windows configuration options apply to 
the VC80. Configuration options are located in the System Tray or the Control Panel. For example, use the System 
Tray to adjust the time, date or volume level and the Control Panel to add, delete or modify software. 

Folder Structure

Microsoft Windows is installed in the \Windows folder. For information on the folder structure, refer to the 
commercially available Microsoft Windows OS Reference Guide.
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VC80 Widows 10 Software Components

The VC80 contains the following software components:

• BIOS

• Embedded Controller firmware

• Microsoft Operating System (Windows 10 IoT Enterprise 2016 LTSB Entry).

• VC Control Panel

The following Windows OS features are unique to the VC80 (dependent on configuration):

• Touch driver

• WLAN/Bluetooth driver

• Ethernet driver 

• GPS

• Zebra printer drivers and tools.

The Embedded Controller manages communication with the following VC80 unique features:

• Heaters

• Battery state

• Haptics

• Vehicle ignition detection.

VC80 Windows 10 Without Operating System

The VC80 can be ordered with no operating system. This configuration requires the user to obtain the following:

• Windows 10 installation media

• A valid product licensing key.

When prompted for driver locations during installation and setup, direct the device wizard to the USB drive 
containing the VC80 specific drivers. 

• For Windows 10 drivers, go to: www.zebra.com/support.

http://www.zebra.com/support 
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Connecting VC80 Windows 10 to Terminal Emulation

The VC80 supports terminal emulators such as TekTerm. For connection to a host, have the following information 
available: 

• Alias name or IP host address

• Port number of the host system 

• Emulation.

To connect to a host: 

1. Ensure the mobile client network settings are correctly configured.

2. Ensure the VC80 is connected to the network if connecting via WLAN.

3. Launch the terminal emulation application. 

TekTerm 

TekTerm is a powerful terminal emulation software application with the ability to interface with multiple Bluetooth 
and serial scanners. TekTerm is pre-licensed and pre-installed on the VC80.

It is recommended to check the latest TekTerm version released for the VC80. For more information regarding 
TekTerm, go to: www.zebra.com/support.


http://www.zebra.com/support.
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VC80 Windows 10 Bar Code Scanners and Settings

The VC80 supports the following types of bar code scanners:

• Tethered scanner connected to COM1 or COM2.

• Tethered scanner connected to a USB host port

• Wireless scanner connected via Bluetooth.

Serial Scanners for VC80 Windows 10 

To configure serial scanners:

1. Open the VC Control Panel and select Power.

2. Enable the power to the port.

Figure 4-1    Enable Power for Serial Scanners (VC80 with Windows 10)
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3. Select TekWedge and select Enable TekWedge to support serial scanners. 

4. Under Properties, make the following selections:

• Enable Good Scan Beep - When enabled, a beep sounds upon a successful decode. When disabled, a 
beep does not sound upon a successful decode. 

• Ignore Caps Lock and Shift - When enabled, the state of Caps Lock and Shift keys do not affect the data 
received from the scanner. When disabled, the scanner data may be converted to upper/lower case based 
on the current state of the Caps Lock and Shift Keys. 

5. Select Config Ports.

Figure 4-2    Enable TekWedge for Serial Scanners (VC80 with Windows 10)

6. Select the new COM port and select Enable Port. 

Figure 4-3    Enable Port for Serial Scanner (VC80 with Windows 10)

7. Select OK.
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USB Scanners for VC80 Windows 10 

The Windows OS loads a USB driver for USB scanners. USB scanners are not controlled or managed by 
TekWedge therefore, post processing such as translation rules can not be used with USB scanners. 123Scan2 can 
be used to create rules and download to the scanner. 

To configure USB scanners, connect the scanner to the VC80 USB port and follow the scanner setup instructions. 
For Zebra scanner guides, go to: www.zebra.com/support.

Bluetooth Scanners for VC80 Windows 10

See Quick Setup for VC80 Windows 10 on page 4-10 for information on connecting Bluetooth scanners. Always 
use TekWedge for VC80 Windows 10 on page 4-25 to configure Bluetooth parameters. 

Pairing Bluetooth Scanners Using Bar Codes for VC80 Windows 10

To pair Bluetooth scanners using bar codes: 

1. Right or left click on the Bluetooth icon in the system tray. 

2. Select Open Settings to access Bluetooth settings.

Figure 4-4    Open Settings (VC80 with Windows 10)

NOTE If the Bluetooth scanner connection to the VC80 is lost, it is recommended to first scan the Unpair bar code 
and then scan the Pair bar code. 

http:// www.zebra.com/support.
http:// www.zebra.com/support.
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3. In the Options tab, select check boxes under Discovery and Connections. 

Figure 4-5    Bluetooth Discovery and Connections (VC80 with Windows 10)

4. In the COM Ports tab, select Add. 

5. Select the radio button Incoming (device initiates the connection).

6. Select OK.

Figure 4-6    Add Incoming Bluetooth Devices (VC80 with Windows 10)
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7. Open the VC Control Panel and select TekWedge. 

8. Enable TekWedge. 

9. Select Config Ports.

Figure 4-7    Enable TekWedge (VC80 with Windows 10)

10. Select the new COM port and select Enable Port. 

Figure 4-8    Enable COM Port for Bluetooth Device (VC80 with Windows 10)

11. Select OK.

12. Scan the bar code to pair the scanner (the scanner must be configured for SPP mode). 
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Settings for VC80 Windows 10 

Select Start Menu > Admin Tools > VC Control Panel to configure the following VC80 settings:

• Quick Setup

• Bezel Keypad

• Haptics Feedback

• Heater Status

• Power

• Push to Talk

• Screen Blanking

• System Info

• TekWedge

• UPS Battery 

• Data Logging

Figure 4-9    VC80 Settings (VC80 with Windows 10)
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Quick Setup for VC80 Windows 10 

Select Start Menu > VC Control Panel > Quick Setup to configure the following quick setup options. 

Links to Microsoft or third party utilities: 

• Touch Panel Calibration - Calibrate the touch panel.

• WLAN Configuration - Configure WLAN. 

• Network Configuration - Configure network parameters such as, Static IP address and DHCP.

• On-Screen Keyboard Configuration - My-T-Soft Keyboard configuration. 

VC80 control panel: 

• Manage VC Configuration - Load, save, or restore default configuration files.

Figure 4-10    Quick Setup Settings (VC80 with Windows 10)
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Touch Panel Calibration for VC80 Windows 10

Hardware 

Associates the pointer device with the monitor/desktop area that is controlled by the device and shows the 
hardware port information. 

• Handling Whole Desktop - Whole indicates the primary monitor. 
• Connected to USB Port - Displays the port connected to the device.
• Add a New Device - Option to add a device. Only non USB devices are manually added. USB devices 

are automatically added. 
• Remove this Device - Option to remove a device. Only non USB or inactive USB are manually 

removed.

Figure 4-11    Hardware Settings (VC80 with Windows 10)

NOTE Select Help for detailed information on the Touch Panel Calibration options. 
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Click Mode

• Interactive Touch - Shows the current click mode emulation for a single touch. The setting is only 
active if the driver is responsible for the pointer handling via the standard mouse interface into the OS. 

• Extended Touch - Vista and above, UPDD can deliver touch co-ordinate data to the Windows OS via 
three interfaces: mouse class, HID class, Win8TI API interface. 

• Visual Notification - Indicates if visual feedback is shown during Interactive Touch right click 
countdown. 

• Interactive Switch Delay - Select the delay pace.

• Sound Options - Configure touch sound options. 

• System Mouse Settings - Adjust the mouse pointer settings defined within the OS. 

• Test Icons - Test Right Click and Double Click. A tick is shown if the click test is successful.

Figure 4-12    Click Mode Settings (VC80 with Windows 10)
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Properties 

• Name - Associates a name to the device. By default the name is the drivers controller device name. 

• Low Pass Filter - Applies a filter to produce a smoother drawing. The speed of drawing is affected, the 
higher the value used. 

• Liftoff Time - Specifies the time interval required to register a stylus lift after the last touch packet is 
received. Lift off time is defined in units of 10ms. 

• Stabilization - Causes small movements to be ignored.

• Averaging - Applies a filter to produce smoother drawings. Filtering can improve drawing without 
affecting the drawing speed. 

• Mode - In a multi pointer device environment, this setting indicates the priority given to the device. With 
the Interlock option, the device can only be used if no other device is in use. The Admin option allows 
any device currently in used to be forced into a pen up state and the device is given immediate priority. 

• Release Time - Defines the interlock release times. 

• Use Lift-off Packet - Only shown if a pen up data packet is generated by the device on stylus lift off. 

• Anchor Mouse - If the device generates a pen up data packet on stylus lift, the mouse cursor returns 
to its original position after using the pointer device. 

• Enabled - Indicates if the device is enabled. This is an option to free up resources without uninstalling 
the driver. 

• Advanced - Includes advanced features such as, Edge Acceleration, Ignore Touches Outside 
Calibrated Area, Support for New Events, and Portrait Rotation.

Figure 4-13    Properties Settings (VC80 with Windows 10)
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Calibration 

• Style - Invoke Calibration styles manually, from an application, a toolbar, or a command line interface. 

• Add a New Style - Add a new calibration style. 

• Number of Points - The number of calibration points determines the calibration pattern used. It is 
highly recommended that four or more points are used for greater flexibility. 

• Margin % - The percentage margin from the edge of the visual display area from which to draw the 
calibration points. 

• Timeout (secs) - Specifies the number of seconds to wait for a calibration touch before canceling the 
calibration procedure. 

• Use Eeprom Storage - Store calibration data in the controllers Eeprom.

• Confirm After Calibration - Select to use new calibration data. 

• Sound Options - Calibration sound options. 

• Calibrate - Invoke calibration procedure for the current device. When calibrating for the first time in a 
multi-monitor environment, calibrating the devices also sets up desktop/touch device relationships.

Figure 4-14    Calibration Settings (VC80 with Windows 10)
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Status 

• Controller Type - The actual controller type in use irrespective of the name given to it in the UPDD 
console. 

• State - Indicates if the device is enabled at the UPDD level. 

• Macro Result - Shows if a controller is initialized by the driver. 

• Replay Initialization Macro - Reinitializes the controller. The macro, if defined, is sent to the controller. 

• Reset Error Counts - Reset the sync error count. Only enabled if error count > 0. 

• Reload Driver Settings - Reload the driver. 

• Show Test Screen - Invoke the test utility. 

• Show Test Grid - Invoke the test utility with drawing grid. 

• Dump Settings - Dump driver settings to a file. The file is useful for support purposes but can also be 
used in subsequent installs to define the initial settings.

Figure 4-15    Status Settings (VC80 with Windows 10)
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Manage VC Configuration for VC80 Windows 10 

• Import - Load VC configuration from file.

• Export - Export VC configuration to file.

• Restore Default - Sets all parameters to factory default.

Figure 4-16    Manage VC Configuration (VC80 with Windows 10)
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Accelerometer for VC80 Windows 10 

Log File Management

• Accelerometer Data Logging- Measures device acceleration and logs the data. 

• Enable/disable Accelerometer Data Logging using the slider.

• Select the Log File Location using Browse button.

• Enter the number of log files to create (1-30).

• Total Size on Disk is calculated automatically by multiplying the number of log files by 2 MB each. 

Log File Content

• Select Log Events for impact and motion related events.

• Select the Impact Detection Threshold using the slider or enter the quantity.
• Select the Motion Detection Threshold using the slider or enter the quantity.

• Select Log Raw Data which exceeds the Data Threshold. 

• Select the Data Threshold using the slider or enter the quantity.
• Enter data Sampling Interval ms (100-2,000).

Figure 4-17    Accelerometer Settings (VC80 with Windows 10)

NOTE Thresholds are rounded to the nearest 0.25 G.
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Bezel Keyboard for VC80 Windows 10 

• My-T-Soft Macro Mapping - Allows remapping and/or assigning various custom functions to the Bezel 
buttons. 

• Assign Bezel Key Scancodes - Map bezel keys one of the following ways: 

• Bezel Key - Assign bezel key using the drop-down menu. 

• Assign Scancodes - Assign scancode function from drop-down menu. To change scancodes to assign 
unique functions/characters, see Chapter 7, Scancode Map. 

• Blue Key

• One-Shot -Activates the Blue key function on the first key press and remains activated until any key is 
pressed again. 

• Lock - Activates the Blue key function on the first key press and remains activated until the Blue key is 
pressed again. 

• One-Shot/Lock - Activates the Blue key function on the first key press. The second Blue key press locks 
the Blue key function. The third Blue key press deactivates the function. 

Figure 4-18    Bezel Keyboard Settings (VC80 with Windows 10)
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Haptic Feedback for VC80 Windows 10 

• Haptics Feedback 

• Enable/disable Haptics Feedback. 

• Select Full Screen or My-T-Soft Only..

Figure 4-19    Haptics Feedback Settings (VC80 with Windows 10)
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Heater Status for VC80 Windows 10 

The VC80 heater ensures optimum performance in freezers. The heater benefits include: 

• Touch screen heater clears condensation on the display.

• Port heater prevents condensation on contacts.

• Audio Codec, UPS Battery and WLAN/BT radio require heaters to operate below freezing temperatures.

• The user interface displays current temperatures.

Heater Status settings: 

• Current Temperature - Displays internal and external temperatures. 

• Display Temperature - Select desired temperature scale.

• Temperature Status

• Green LED - Heater is enabled.

• Red LED - Heater is disabled.

• Start Test - Verifies heater operation when temperature increases. 

Figure 4-20    Heater Status Settings (VC80 with Windows 10)
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Power for VC80 Windows 10 

• Interface Power Configuration - Enable/disable power for serial and USB ports. 

• Vehicle Ignition Detection 

• Start VC when vehicle ignition changes from OFF to ON state. 

• Shut down VC when vehicle ignition changes from ON to OFF state.

• Enter desired minutes to delay in the Delay field. 

Figure 4-21    Power Settings (VC80 with Windows 10)

NOTE Ignition detect requires a CA1220 power extension cable. 

NOTE To configure a serial scanner, turn on the power to the port and in TekWedge settings, enable 
the port and TekWedge (seeTekWedge for VC80 Windows 10 on page 4-25).
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Push To Talk for VC80 Windows 10 

• Connection Status - Displays the current connection status.

• PTT Handset Scan Code - Scan code for bezel key setting.

• Speaker - Enable the Bezel Speaker or PTT Handset Speaker.

Figure 4-22    Push To Talk Settings (VC80 with Windows 10)
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Screen Blanking for VC80 Windows 10 

The optional Screen Blanking setting turns the screen off when the vehicle is moving and back on when the vehicle 
is stopped. 

• Screen Blanking - Enable/disable screen blanking feature. 

• Delay

• Blanking the VC Screen - Screen blanking duration in seconds.

• Re-Enabling the VC Screen - Re-enable screen duration in seconds.

• Blank Screen Based On 

• Com Port 1 or Com Port 2.

• Blank screen when port pins are connected - Select blank screen option. De-select to disconnect the 
blank screen option.

Figure 4-23    Screen Blanking Screen (VC80 with Windows 10)

NOTE To use Screen Blanking, first connect one of the two DB9 serial ports on the VC80 to a user-supplied 
switch or relay. See Connecting Switch for Screen Blanking on page 2-10.
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System Info for VC80 Windows 10 

The System Info screen provides information about the system such as the Serial Number, OS Details, and SKU 
Detail. The system information is required for technical support inquiries. 

To export the system information to a text file:

1. Select Save. 

2. Select a location to save the file to. 

3. Name the file in the File Name field.

4. Select a file type from the Save As Type drop-down menu.

Figure 4-24    System Information (VC80 with Windows 10)
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TekWedge for VC80 Windows 10 

TekWedge provides the ability to interface with Serial and Bluetooth scanners. 

• TekWedge to support serial scanners - Enable/disable TekWedge support for serial and Bluetooth 
scanners. 

• Properties 

• Enable Good Scan Beep - VC80 beeps when data is received from the scanner. 

• Code Page - Select code page from drop-down menu.

• Data Transmission - Select one type of data transmission.

• Copy/Paste (Application supports Ctrl-V) - Copy/Paste is efficient for large amounts of scanned data. 

• Keyboard Wedge.

• Ports and Translation Rules 

Figure 4-25    TekWedge Settings (VC80 with Windows 10)

NOTE To configure a serial scanner, turn on the power to the port (see Power for VC80 Windows 10 
on page 4-21) and in TekWedge settings, enable the port and TekWedge.
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• Config Ports - Select the COM Port from the ports window and adjust the port settings such as Baud 
Rate, Data Bits, Parity, Flow Control, Stop Bits, and Timeout as desired. 

• Set to Default - Sets the default for the selected COM port. 

• Clear Unavailable Ports - Clears unavailable ports such as ports that are no longer active.

Figure 4-26    Config Ports (VC80 with Windows 10)

NOTE For large bar codes, adjust the Timeout duration. The longer the timeout, the slower the scans. 
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• Config Translation Rules - Allows you to define up to 10 cases, each consisting of up to 10 rules in 
sequential order. Only one case is applied to a bar code and a case is applied if all rules specified in the 
case are successful. If a rule within a case fails, the entire case fails.

• Case Rules -The case rules are defined as follows:

• No Rule
• Verify Barcode Size — Verifies the barcode size. Assign this rule first, before creating subsequent 

rules.
• Match at Index — Matches the match string at a specified index.
• Add Barcode Prefix/Suffix — Adds a global prefix or suffix.
• Search and Replace — Replaces all instances of the match string.
• Match and Replace at Index — Matches the match string at a specified index and replaces/changes 

it.
• Replace at Index — Replaces/changes unspecified data in a given range.

Translation information about the status of each case/rule is displayed in the scan log file. This is useful to 
determine why a rule is failing.

Select a Case/Rule to modify and then select the Scan Type drop-down menu to apply a rule.

Figure 4-27    Translation Rules (VC80 with Windows 10)
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UPS Battery Status for VC80 Windows 10 

• Information - Displays the current battery information such as the Serial Number, Manufacture Date, and 
Remaining Battery Life. 

• Notification - Enable/disable Low Battery Notifications and enter a Threshold percentage for low battery 
life warnings. 

Figure 4-28    UPS Battery Settings (VC80 with Windows 10)
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Data Logging for VC80 Windows 10 

Data Logging logs information about VC80 custom features.

• Log Information Level

• Source - Select a source from the drop-down menu such as Heaters, Haptics, UPS Battery.

• Content - Select a priority level from the drop-down menu such a Critical, Major, Minor. 

• Disable All Logging - Removes logging VC80 custom feature information. 

• Log File Management - Select a Log File Location, quantity of log files in the Create up to field, and disk 
size (default is 2 MB) in the Total Size On Disk field. 

Figure 4-29    Data Logging Settings (VC80 with Windows 10)

NOTE Application crash dump files are captured and stored in a restricted folder permitted for 
Administrators only (C:\VC\Logs or C:\Windows\MiniDmp).
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My-T-Soft

My-T-Soft offers a database of existing keyboard layouts for screen keyboard customization and key mapping. 
Each VC80 has access to a Zebra account on the Build a Board website for keyboard layouts. Unique custom 
keyboard layouts may be acquired for additional license fee(s). 

To access My-T-Soft, go to: www.build-a-board.com. 

Figure 4-30    My-T-Soft Screen Keyboard Layout Examples

www.build-a-board.com
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All VC80s are My-T-Soft licensed through a common account which is only available from the VC80.

To access My-T-Soft: 

1. Select Start > Select My-T-Soft > Licensing Information.

Figure 4-31    My-T-Soft License Information

2. The UAC window displays. Select Yes.

3. In the IMG License Manager menu, select Go to My Build-A-Board.com Account.

Figure 4-32    IMG License Manager

4. The Zebra account web page displays. Download existing keyboards or create your own and save in the Zebra 
account. 

NOTE To create a private collection of keyboards, you must acquire your own account. 
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Windows Management Instrumentation

Windows Management Instrumentation (WMI) is a free component of the Microsoft Windows® operating system 
that provides a scalable system management infrastructure. Using a free provider plug-in from Zebra, WMI 
enables local and network remote management of scanner(s). System administrators can leverage WMI to query 
and set information on desktop systems, applications, networks, components, and accessories, such as a scanner.

For more WMI information, go to:
• https://msdn.microsoft.com/en-us/library/aa384642(v=vs.85).aspx
• http://www.zebra.com/support

GPS

U-Center is used to set up GPS on the VC80. 

To set up the GPS:

1. Ensure that the antenna is properly installed on the GPS port (see Figure 1-2 on page 1-3).

2. Open U-Center by selecting Start > Program Files > U-Center.

3. Ensure that the receiver is connected. See Figure 1-2 on page 1-3. After approximately thirty seconds, some of 
signals bars turn to green. This signifies that the GPS has obtained 3D lock. 

Figure 4-33    U-Center Connection

COM Port Connection

https://msdn.microsoft.com/en-us/library/aa384642(v=vs.85).aspx
http://www.zebra.com/support
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Satellite Level

To view the Satellite Level, select View > Docking Windows > Satellite Level.

Location Coordinates

To view Location Coordinates, select View > Docking Windows > Data.

Figure 4-34    Location Coordinates

U-Center Software

• For detailed U-Center information, refer to the U-Center User Guide at:
https://www.u-blox.com/sites/default/files/u-center_UserGuide_%28UBX-13005250%29.pdf

• Other applications/software such as Visual GPS can be used to collect location data by communicating with 
the GPS receiver.

https://www.u-blox.com/sites/default/files/u-center_UserGuide_%28UBX-13005250%29.pdf
https://www.u-blox.com/sites/default/files/u-center_UserGuide_%28UBX-13005250%29.pdf
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Kiosk

The Kiosk application provides a simple lock-down mode for the Zebra VC80 and ET5X products. When activated, 
the standard Windows shell is replaced so that device usage is restricted to a desired application such as, a 
browser or custom workplace application.

The Kiosk app is included in the VC Control Panel installer. It is installed and uninstalled from the VC Control 
Panel. Access to Kiosk is from an icon located on the desktop.

Configuration and Activation of Kiosk Mode

Run the application directly using Start/Run… or by launching it from Windows Explorer. The path location is:

C:\Program Files\VCControlPanel\Kiosk.exe

The application requests administrative privileges to make the necessary changes to activate kiosk mode. Once 
logged in as Admin, the Configuration & Launcher window displays. Each section of the configuration window is 
detailed as follows: 

Shell Settings

Under Shell Settings, click on Browse and select the application to be executed instead of the Windows interface. 
In the Figure 4-35 example, Internet Explorer is configured. You may choose any application you desire to be the 
main application for Kiosk Mode.

Figure 4-35    Kiosk Shell Settings 

The Shell Settings options provide enhanced control for the look and behavior of the selected application.

• Application - Locate the application to launch using the Browse button.

• Remove Menu Bar - Start the application without the menu bar.

• Remove Title Bar - Start the application without the title bar.

• Auto Relaunch on Close - If the application is closed by the user, it starts again automatically.

• Maintain Focus - Maintain the focus as the top most application launched by Kiosk.
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Security

Located under Security, click on the Select Exit Key drop-down arrow to choose one of the following key 
combinations to be used to exit kiosk mode: CTRL+ALT+Q or CTRL+ALT+L. 

When the exit kiosk mode key combinations are pressed, a window displays to Log Out or Exit kiosk mode. For 
both of these actions, you may require a password to be entered by selecting the Require Admin Password 
check box and entering a password in the Password field.

Exiting Kiosk Mode requires administrative privileges and must be done from an administrative account or by 
providing administrator credentials. The kiosk password is used to prevent unauthorized logging out.

Figure 4-36    Kiosk Security Settings 

Lockdown

The task manager allows any application to run and be controlled manually which defeats the purpose of kiosk 
mode. After testing kiosk mode, it is recommended to select the Disable Task Manager check box for production 
use to prevent the task manager from being activated (for example, by selecting Ctrl-Alt-Delete).

Figure 4-37    Kiosk Lockdown

Monitor Utility

When kiosk mode is enabled, it displays icons that shows the Wi-Fi (WLAN) status and battery status. You can set 
preferences as follows: 

• Enable Monitor - Display the signal strength (RSSI dbm).

• Default Location - Select a location to display the icons: Top Left, Top Right, Bottom Left, Bottom Right. 
Select the Fixed check box to lock the location. 

• Color Mode - Select the drop-down menu to choose a background color: Black, White, or Transparent.

• Show SSID - Select to check box to display the current access point SSID

• Show Battery Level- Display the charge level of the battery as a capacity percentage.

You can try the settings without going into kiosk mode by saving the configuration, select Apply config, and 
running the monitor application manually. There is no exit button. The monitor application must be closed from the 
Task Manager manually. The monitor application is located at:
C:\Program Files\VCControlPanel\WiFiMonitor.exe

Figure 4-38    Kiosk Monitor Utility
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Additional Software

• Launch SIP - Start the My-T-Soft on-screen keyboard when the kiosk starts. An on-screen keyboard or a 
physical keyboard is necessary to exit kiosk mode.

• Enable TekWedge - Start TekWedge when the kiosk starts. This software causes scanned bar codes to be 
treated as keyboard input.

• Enable Bluetooth - Start the WIDCOMM Bluetooth software when the kiosk starts to allow pairing (for 
example, Bluetooth devices).

• Launch Custom - To specify another custom application to start up when the kiosk starts, select the Launch 
Custom check box. Select Browse to choose the desired executable. This application is in addition to the 
app configured under Shell Settings.

Figure 4-39    Additional Software

Completing Setup
Select Apply Config to save your configuration settings.

To launch kiosk mode, select Launch Kiosk to log out and launch Kiosk mode. You need your exit key and kiosk 
password. 

Kiosk settings are applied to the computer and then you are logged off. Kiosk mode is now active and applies to all 
accounts. Upon login, the configured kiosk applications run.

Figure 4-40    Completing Kiosk Setup

Exiting Kiosk Mode 
To log off or exit kiosk mode:

1. Press the key combination (see Security on page 4-35) to access the Kiosk Control.

2. If security was configured to require a password, enter your password for both of the following actions.

• Log Off - Logs off of the account to exit all open applications.

• Exit Kiosk - Deactivates kiosk mode. Administrative privileges are required. Accept the 
Run-as-Administrator request and supply administrative account credentials if exiting from a 
non-administrative account. Kiosk settings are removed from the computer and you are logged off. Kiosk 
mode is no longer active for any account. Upon login, the Windows shell runs.

Figure 4-41    Exit Kiosk Mode
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Launching Applications without UAC Prompt

To launch applications without the UAC prompt:

1. Find the installation path of the application (for example, C:\Program Files\ApplicationName) and right click on 
the application EXE file.

2. Select Properties.

3. Select the Compatibility Tab.

4. Check the option Run this Program as an Administrator.
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CHAPTER 5  MAINTENANCE AND 
TROUBLESHOOTING
Introduction

This chapter includes instructions on cleaning the device and provides troubleshooting solutions for potential 
problems during device operations.

Cleaning 

Housing Cleaning

Clean the fully assembled VC80 vehicle mount computer housing using only a mild detergent on a lightly damp-
ened soft cloth. 

Touchscreen Cleaning

• Use neutral detergent or isopropyl alcohol on a clean soft cloth to clean the panel surface. Do not use any 
kind of chemical solvent, acidic or alkali solution.

WARNING Danger due to electric shock when cleaning and maintaining the device. To avoid 
electric shock, turn the VC80 off and disconnect it from the power supply before 
cleaning or maintaining it. 

CAUTION Do not use compressed air, a high-pressure cleaner or vacuum cleaner, as this can damage 
the surface. Using a high-pressure cleaner poses the additional risk of water entering the 
device and damaging the electronics or display.
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Touchscreen

The VC80 is equipped with a resistive touchscreen.

Operation of the resistive touchscreen is recommended with:

• Clean, dry fingers.

• Clean, dry, soft gloves.

• Suitable touch stylus (plastic or wood, rounded tip).

CAUTION - Keep the touchscreen clean (see Touchscreen Cleaning on page 5-1).
- Do not apply adhesives to the surface.
- Avoid high voltage and/or static charge.
- Do not use ball point pens, writing utensils, tools, or sharp objects.
- Touch the panel with your finger or stylus only to ensure normal operation.
- Operate in a stable environment. Abrupt variation of temperature and humidity may cause malfunction.
- Avoid applying excessive activation force or sudden impact on the touchscreen surface. 
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Troubleshooting

Table 5-1    Troubleshooting 

Symptom Possible Cause Solution

The vehicle 
computer does 
not power on or 
shuts off 
suddenly.

The power cable ignition 
sense wire (yellow) is not 
connected properly. 

Verify that the power cable is connected properly. See Wiring 
Vehicle Power to the VC80 on page 2-4.

Power cable not 
connected properly or 
unplugged.

Connect power cable to power cable portion underside of 
vehicle computer. Turn the main power switch on.

If the vehicle computer is 
powered by a vehicle 
battery, the vehicle 
battery is depleted.

Replace or charge the vehicle battery.

Cannot see 
characters on 
display.

Vehicle computer not 
powered on (Power LED 
is Off).

Press the Power button on.

Screen is too bright/dark. Adjust the brightness; see Figure 1-1 on page 1-3.

Display not adjusted 
properly.

Select Display in the Control Panel settings and adjust the 
display.

The vehicle computer is 
in low power mode 
(Power LED is on).

Press the Power button to turn on the vehicle computer.

The touchscreen 
is not working.

Display not properly 
calibrated.

Recalibrate the screen through the Touch Panel Calibration 
utility (see Touch Panel Calibration for VC80 Windows 7 on 
page 3-11). If problem continues, contact Zebra support. See 
Service Information on page ii-xii.

Replacement screen 
protector was not applied 
correctly.

Replace or re-apply screen protector.
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The optional 
serial scanner 
does not 
operate.

Scanner is not properly 
connected to the vehicle 
computer.

Connect the scanner to the COM1 port. Ensure the proper COM 
port is selected in the TekWedge application, see TekWedge 
for VC80 Windows 7 on page 3-24. If the problem continues, 
refer to the scanner Product Reference Guide.

TekWedge application is 
not enabled or set to the 
correct COM Port.

Ensure that the TekWedge application is enabled and set to the 
correct port. See TekWedge for VC80 Windows 7 on page 
3-24.

External power is not 
connected.

Verify external power connection.

No sound is 
heard when you 
tap the 
touchscreen or 
press a key.

Volume is turned down. Adjust the volume in the Control Panel.

Application currently 
running disabled the 
sound.

Configure the application to enable the sound.

Faulty speaker. Contact Zebra support at www.zebra.com/support.

The optional external 
speaker cable is 
connected without the 
speaker.

Connect the external speaker or disconnect the cable.

Power is not enabled on 
the COM port. 

Ensure the power is applied to the COM port by the VC80.

Missing pixels on 
the display.

Faulty LCD. Contact Zebra support. See www.zebra.com/support.

COM1 or COM2 
port is not 
working.

Another application, or 
SerialWedge is using the 
port.

Stop the application using the port or change the TekWedge 
COM Port Settings.

No keys are 
working on the 
optional or 
built-in keyboard.

The optional keyboard is 
not properly connected to 
the vehicle computer.

Check the cable connections between the keyboard and the 
vehicle computer.

The application does not 
require keyboard input.

Configure the application to use the keyboard.

Vehicle computer is not 
responding.

Warm boot the vehicle computer.

Table 5-1    Troubleshooting 

Symptom Possible Cause Solution

http://www.zebra.com/support
http://www.zebra.com/support
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The vehicle 
computer 
cannot find any 
Bluetooth 
devices nearby.

Too far from other 
Bluetooth devices.

Move closer to the other Bluetooth device(s).

The Bluetooth device(s) 
nearby are not turned 
on.

Turn on the Bluetooth device(s).

The Bluetooth device(s) 
are not in discoverable 
mode.

Set the Bluetooth device(s) to discoverable mode. If needed, 
refer to the device’s user documentation for help.

The Bluetooth 
scanner does 
not pair 
Provides the 
wrong beep 
sequence after 
scanning pairing 
bar code.

The COM ports are not 
configured correctly; 
There is no BT incoming 
port; The incoming port is 
not enabled in 
TekWedge.

Enable incoming port in TekWedge > Ports Config
Bluetooth Scanners for VC80 Windows 7 on page 3-6 or 
Bluetooth Scanners for VC80 Windows 10 on page 4-6.

Bluetooth COM port is 
disabled while connected 
to TekWedge.

To re-establish a connection:
1. Disable the BT incoming COM port

2. Disable this same COM port in TekWedge > Port Config >

3. Unpair the scanner.

4. Reboot the VC80.

5. Reconfigure according to Bluetooth Scanners for VC80 
Windows 7 on page 3-6 or Bluetooth Scanners for VC80 
Windows 10 on page 4-6.

When installed 
on some electric 
forklifts, the 
scanner range is 
shorter then it is 
when installed 
on other forklifts.

Electro-magnetic 
interference caused by 
the forklift.

Consult forklift vendor about reducing the interference by 
adding a capacitor between the forklift chassis and its 
battery's negative terminal, or another recommended solution.

Table 5-1    Troubleshooting 

Symptom Possible Cause Solution
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CHAPTER 6 ACCESSORIES AND 
MOUNTING 
Introduction

This chapter provides accessory information, mounting options and instructions. 

Accessories 

Table 6-1    Accessories

Model Number Accessory

Antennas

AN2010 Antenna, dual band, 802.11 a/b/g/n, 2 dBi, reverse polarity SMA connector, magnetic 
mount, 2.9m

AN2020 Antenna, 2.4GHz, 802.11 b/g, 5 dBi, reverse polarity SMA connector, magnetic 
mount, 2.9m

AN2030 Whip antenna (stubby), dual band, 802.11 a/b/g/n, 2.4GHz 2dBi, 5GHz 3.7 dBi, 
reverse polarity SMA connector

20667-002 Whip antenna (stubby), 802.11 b/g - dipole 2 dBi reverse polarity SMA connector

AR1000 Right Angle SMA reverse polarity plug-jack adaptor

AN000090A01 GNSS antenna, magnetic mount, 2.9 m cable
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Mounts

MT4200 Quick release mount 

MT4205 Mounting plate for the MT4200 quick release mount

MT4210 Adaptor bracket kit for 82XX quick release mount

MT4510 RAM rectangular base with 2.25" rubber ball

MT4301 RAM mount, 4" arm

MT4302 RAM mount, 12" arm

MT3501 VESA base (for 4" or 12" RAM arm)

MT3502 Circular base (for 4" or 12" RAM arm)

MT3505 Clamp base (for 4" or 12" RAM arm), 2" max. width 

MT3507 Clamp base (for 4" or 12" RAM arm), 3" max. width 

MT3509 Rail base (for 4" or 12" RAM arm), 1-1/4" to 1-7/8"

MT3510 Rail base (for 4" or 12" RAM arm), 2" to 2 1/2"

KT-SCANMNT-VC80-R Side mounted holder for scanner

KT-KYBDTRAY-VC80-R Keyboard mounting tray (includes tilting arms, knobs and screws) for VC80 and iKey 
keyboards

KT-KYBDMNT-VC80-R Function/Numeric keypad side mount bracket

Table 6-1    Accessories

Model Number Accessory
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Keyboard

9010376 iKey keyboard, 86 keys (12 Function keys), pointing device, red LED backlight, USB

9010377 iKey keyboard, 72 oversized color arranged keys (8 function keys), USB

SLK-101-M-USB-3F iKey keyboard, 101 keys (12 function keys), large numeric pad, backlight, USB

Speaker/Mic

M1000 Speaker/Mic with push-to-talk function

Miscellaneous

KT-SPRTCT-VC70-05R Screen protector pack of 5

SL0001 Stylus and stylus holder

KT-VC80-BTRY1-01 Spare battery

Table 6-1    Accessories

Model Number Accessory
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Power Supplies and Cables

PS000145A01 100/240 VAC power supply, 24 VDC, 6.5 A, 150W (AC power cord sold separately)

PS1370 Pre-Regulator, 19 - 90 VDC in, 15 VDC out, 90 W

CB000417A01 DC power adaptor to VC50

CB000416A01 DC Power adaptor to VC70

CA1210 Power extension cable, DC, 6', waterproof

CA1230 Power extension cable for pre-regulator

CA1220 Power extension cable, DC, 180 cm, with ignition sense

CA1300 Screen blanking cable (DB9 to open wires)

CB-000433-01 CAN Bus cable (RJ45 to Deutsch)

Table 6-1    Accessories

Model Number Accessory
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External Bar Code Scanners

The VC80 supports external hand-held decoded scanners and imagers connected via USB, RS-232, or Bluetooth. 
See VC80 Windows 7 Bar Code Scanners and Settings on page 3-4 to add scanner(s).

When a bar code is scanned successfully, the VC80 beeps if configured appropriately. A poorly printed or damaged 
bar code may not decode properly. In this case, use the keyboard to enter data from the bar code. 

For more information, refer to the specific scanner manual at: www.zebra.com/support. 

CAUTION Only use Zebra approved scanners.

http://www.zebra.com/support
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VC80 Antenna Options

Antenna hardware configurations are located in Table 6-1 on page 6-1. To determine the best antenna option for 
your location, contact your Zebra representative.

Figure 6-1    VC80 Antenna Options

IMPORTANT If using a magnetic mount antenna, place it in a location that balances the need for the VC80 to 
communicate with the access points and local Bluetooth peripherals.

AR1000

AR3010

AN2020

AN2030

AN2010

Contact 
Insulator 

SMA
Connector

Black Powder Coat 
Over Nickel Chrome 
Plated Steel

COAX LMR 
200

Red Cap Vinyl 

80 lbs Pull
Strength
Magnet

NHOMF

Magnetic Mount for
AN2010 and AN2020
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VC80 Mounting Accessories

WARNING Failure to install the mount correctly, or modifications to the mount, may result in serious 
injury or damage to property. Contact Zebra Technical Support or your Zebra representa-
tive if you have problems installing this mount. To ensure operator safety, you must use a 
calibrated torque wrench and the supplied mounting hardware when fastening the com-
puter and mount. Use of this mount in vehicles driven on public roads or highways is 
prohibited. Contact Zebra for further details.

Before mounting a VC80 in a vehicle, there are a number of operator safety issues that 
require careful attention. When mounting a VC80 use only approved Zebra mounting 
hardware and mounting parts which are specific to the VC80 model purchased. An 
improperly mounted VC80 or use of non-approved parts may result in one or more of the 
following: operator injury, property damage, operator visibility obstruction, operator dis-
traction, and/or poor ease of egress for the operator. Zebra strongly recommends that you 
seek professional mounting advice from the vehicle manufacturer.

If it is necessary to mount the VC80 overhead, or in any position that could cause injury to 
the operator should the unit fall, it is critical that a secondary tether or other fail safe 
device be installed. 

The following restrictions must be strictly enforced: 

• Do not use the mount and/or the VC80 as a hand-held. Using the mount in this manner 
may cause the person to fall or dislodge the mounting hardware and/or mounts.

• Do not add weight or attach any other items to the mount or VC80. Additional elements 
may fall causing injury, or may increase the chance of failure and/or damage in 
mounting hardware and/or mounts.

• Mounts used in industrial or vibration generating environments may be subjected to 
fatigue, stress, and/or part wear. A periodic inspection of the mounting hardware and 
mounts should be performed to ensure parts are retightened to the correct torque, free 
of fractures, excessive wear, and/or other environmental damage. Any parts found to 
be unsafe should be removed and replaced immediately. After inspection or 
replacement of parts, readjust the mount as outlined in the pertinent sections below. 

• Cable routing within a vehicle cab also requires careful consideration, especially for 
separately connected scanners and other devices with loose cables. If you are unable 
to obtain suitable advice, contact Zebra for assistance. For better protection, the 
equipment should be mounted inside the vehicle roll cage.

• When charging the vehicle battery, the VC80 must be either disconnected from the 
battery or it must be determined that the maximum allowed input voltage of the VC80 is 
not exceeded.
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MT43XX RAM Mount

The VC80 may be installed using an articulating RAM Mount (Model MT43XX – 4 in. or 12 in. arm) secured to 
either a VESA or circular base.

The RAM articulating mount can be installed in a variety of orientations (see Figure 6-3 on page 6-9). Select the 
best orientation for the specific application. Preferred orientations maintain the center of mass of the computer 
assembly, directly over the center of the base. 

For detailed mount installation information, refer to the instructions included with the mount kit.

Figure 6-2    Orientation of Vehicle-Mount Assembly

IMPORTANT To avoid injury, this device must be properly secured when in a moving vehicle. 

Keep this device away from magnetic fields.

Do not place the computer near a television or radio receiver.

Do not disassemble the VC80 computer as there are no user-serviceable parts inside.

IMPORTANT The operator can easily adjust the tilt and rotation of the VC80. Use care to avoid operator 
injury or equipment damage if the computer slips due to a loosened hand screw.
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Optional Mounts

One of the following optional mounting kits shown in Figure 6-3 may be substituted for the Vesa base or the circular 
base when mounting to a post or forklift roll cage.

To assemble the optional mount kit: 

1. Mount the clamp base and lower base around the shaft.

2. Place the screw through the clamp and the lower base, and affix with the nut.

3. Torque to 26 in-lbs. 

4. Secure the RAM standard arm by inserting the RAM balls into both ends of the arm sockets.

Figure 6-3    Optional Mount Kits

Plate Bases for MT35XX Mounts

Plate bases are not recommended for forklift mounting solutions. If this requires a plate rather than a clamp base, 
you must penetrate into the structure of the vehicle. This requires additional hardware. The following plate bases 
are available: 

• MT3501 - VESA Plate 

• MT3502 - Circular Plate
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MT4200 Quick Release Mount

The MT4200 Quick Release Mount allows a removal without the need for tools.

Assembling MT4200 

To assemble the MT4200 Quick Release mount:

1. Place the back mounting plate hooks into the base plate slots.

2. Snap spring clips into place.

Figure 6-4    MT4200 Quick Release Mount Assembly
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Attaching MT4200 to VC80

To attach the MT4200 Quick Release Mount to the VC80: 

1. Line up the MT4200 mounting bracket holes with the holes on the sides of the VC80 (two on each side). 

2. Place the washer spring lock onto the hex head screw.

3. Place the washer flat onto the hex head screw (on top of the washer spring lock). 

4. Screw the bracket onto the VC80 (total of four). Torque to 34.7 in-lbs. 

Figure 6-5    VC80 and MT4200 Assembly
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MT4210 Adaptor Bracket

The MT4210 Adaptor Bracket is for use with older mounts, such as the 82XX Quick Release Mount.

To assemble the MT4210 Adaptor Bracket:

1. Line up the MT4210 mounting bracket holes with the holes on the sides of the VC80 (two on each side). 

2. Place the washer spring lock onto the hex head screw.

3. Place the washer flat onto the hex head screw (on top of the washer spring lock). 

4. Screw the metal adaptor bracket onto the VC80 (total of four). Torque to 34.7 in-lbs.

Figure 6-6    MT4210 Adaptor Bracket Assembly 
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CHAPTER 7 SCANCODE MAP
Introduction

This chapter provides information on the integrated bezel scancode map for the VC80.
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Integrated Keypad

The VC80 has six integrated programmable keys located below the display. Each programmable key can be modi-
fied by the Blue key for a total fourteen keys.

Figure 7-1    VC80 Front Keys and LED Indicators

To change scancodes to assign unique functions/characters, edit the scancodes.txt file in 
c:\Program Files\VCControlPanel. 

Figure 7-2    Scancode Map

101 Keyboard Scan 2 Make

~ 0E

! 16

@ 1E

# 26

$ 25

% 2E

^ 36

& 3D

* 3E

( 46

) 45

_ 4E

+ 55

Backspace 66

Tab 0D

Q 15

W 1D

E 24

R 2D
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Y 35

U 3C

I 43

O 44
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P 4D

{ [ 54

} ] 5B

| \ 5D

Caps Lock 58

A 1C

S 1B

D 23

F 2B

G 34

H 33

J 3B

K 42

L 4B

: ; 4C

“ ‘ 52

5D

Enter 5A

L Shift 12

61

Z 1A

X 22

C 21

V 2A

B 32

N 31

M 3A

< , 41

> . 49

? / 4A

51

R SHIFT 59

L CTRL 14

L ALT 11

101 Keyboard Scan 2 Make
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Space Bar 29

R ALT E0 11

R CTRL E0 14

Num Lock 77

Numeric 7 6C

Numeric 4 6B

Numeric 1 69

Numeric 8 75

Numeric 5 73

Numeric 2 72

Numeric 0 70

Numeric * 7C

Numeric 9 7D

Numeric 6 74

Numeric 3 7A

Numeric . 71

Numeric - 7B

Numeric + 79

6D

Numeric Enter E0 5A

Esc 76

F1 5

F2 6

F3 4

F4 0C

F5 3

F6 0B

F7 83

F8 0A

F9 1

F10 9

F11 78

F12 7

Scroll Lock 7E

101 Keyboard Scan 2 Make



APPENDIX A  SPECIFICATIONS
Introduction

The following tables summarize the device’s intended operating environment and technical specifications.
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Technical Specifications

Table A-1    Technical Specifications

Item Description

Physical and Environmental Characteristics 

Dimensions 10.83 in. L x 9.35 in. W x 3.46 in. D

275.2 mm L x 237.4 mm W x 88 mm D

Weight 8.6 lbs/3.9 kg

Display:

Size

Resolution

Brightness

 

10.4 in. color XGA

1024 x 768 LCD withLED backlight; 24 bit color depth
400 NITs or 1000 NITs 

UPS and 
Backup Battery

Rechargeable UPS battery for operation during power loss; Internal rechargeable battery 
for multiple months of real-time clock backup

IP Sealing IP 66

Interface Ports Standard sealed and secured connectors:

• Two RS-232 serial port

• One standard USB port

• One powered USB port

• One 3.5 mm audio jack

• Optional ethernet (10/100/1000 Mbps) or isolated CAN bus port with SAE J1929 
support

Thermal Shock -22° to 122° F/-30° to 50° C

User Environment

Operating 

Temperature

-22° to 122° F/-30° to 50° C

Storage 

Temperature

-22° to 140° F/-30° to 60° C

Relative 

Humidity

5% to 95% non-condensing (standard version)

5% to 95% condensing (freezer version with internal heating)

Salt Fog 48 hours of 5% solution at 35° C

Solar Radiation MIL STD 810-G, Method 505.5, Procedure I

ESD +/-15kV air discharge

+/-8kV direct discharge



Specifications A - 3
Integrated 
Sensors

Motion (accelerometer); temperature; ignition

Shock/Vibration IEC 60721-3-5M3; MIL-STD 810G; Method 514.6; MIL-STD 810G; Method 516.6

Power 
Consumption

• 16W: Display brightness at 1/2, keyboard backlight off, radio in received mode, 
UPS battery fully charged. 

• 38W: Full display brightness, full external keyboard backlight on, radio running ping 
test, UPS battery is charging, scanner connected. 

• 84W: Full display brightness, full external keyboard backlight on, radio running ping 
test, UPS battery is charging, scanner connected, touch screen heater on. 

Performance Characteristics

CPU/RAM Intel E3825 Dual Core, 1.33 GHz with 2GB RAM or

Intel E3845 Quad Core, 1.91 GHz with 4GB RAM

Operating 
System

• Windows Embedded Standard 7, 64 bit; Windows 7 Professional, 64 bit

• Windows 10 IoT Enterprise 2016 LTSB Entry

Internal 
Expansion

Two PCIe mini slots (one standard, one optional); one M.2 slot

Mass Storage mSATA SSD: 32 or 64 GB

Additional 
Software

My-T-Soft configurable on-screen keyboard; Scanner Wedge with code manipula-
tions; Tekterm

Application 
Development

Standard Windows plus WMI additions

Touchscreen • Resistive touchscreen with passive stylus or finger operation

• Freezer version includes integrated touchscreen heater for evaporates external 
condensation.

• Construction: Film-Glass (FG)

• Hardness of surface: 3H (ASTM D3363) 

• Resistance: 35 million actuations

Audio High volume 87 dBA speaker (at 1 foot distance)

Push-to-Talk External optional speaker/microphone

WLAN Wireless Data Communications

WLAN radio IEEE 802.11a/b/g/n/ac 2x2 MIMO

Table A-1    Technical Specifications (Continued)

Item Description
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Output Power 2.4GHz=+17.5dBm max, 5GHz=+17.5dBm max

Data Rate 867Mbps @ 5GHz, 300Mbps @ 2.5GHz

Frequency 
Range

Country dependent

2.4GHz band (802.11b/g/n) = 2400-2483.5MHz

5GHz band (802.11a/n/ac) = 5150-5350MHz, 5470-5855MHz.

Antenna Internal or external

WLAN Security WPA, WPA2, AES, TKIP, WEP, 802.11x, CCX v4

WPAN Wireless Data Communications

Bluetooth Bluetooth V2.1 + EDR (Window7/10)

Bluetooth V4.0 Smart Ready (Windows 10)

GPS

GPS Optional with DGPS support

Power Supply

Power Supply Internal power supply 12-48V nominal

Table A-1    Technical Specifications (Continued)

Item Description
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VC80 Drill Hole Dimensions

Figure A-1    VC80 Drill Hole Dimensions
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